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Copyright

The 2019 Drake Tax User’s Manual Supplement: Corporations, Drake Tax Software, and any 
other related materials are copyrighted material. All rights are reserved by Drake Enterprises, 
LTD, including all ownership rights. This document, associated software, and related material 
are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and reproduce the 
material in this document in an unaltered form only for your personal, non-commercial use or 
for non-commercial use within your organization. Copyright, trademark, and other proprietary 
notices may not be removed.

© 2019 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, there is no 
warranty, expressed or implied, to that effect. Drake Enterprises, LTD, assumes no liability for 
damages or claims resulting from the use of the information contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake 
Enterprises, LTD.

Microsoft® and Windows® are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and other countries.

Other product names mentioned in this manual may be trademarks or registered 
trademarks of their respective companies.
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Drake Tax Manual Supplement: 1120 What’s New in Drake Tax for Corporations
Corporations (1120)

THE BASICS OF DATA ENTRY FOR A CORPORATION 
(1120, 1120-C, 1120-H) RETURN ARE THE SAME AS 
FOR A 1040 RETURN. NAVIGATION THROUGH DATA 
ENTRY, FIELD- AND SCREEN-LEVEL HELP, AND 
KEYBOARD SHORTCUTS ALL FUNCTION AS THEY DO 
IN THE 1040 PROGRAM. SEE THE 2019 DRAKE TAX 
USER’S MANUAL FOR THE BASICS OF USING THE 
PROGRAM. (THE MANUAL IS AVAILABLE ON THE 
INSTALLATION CD AND ON THE DRAKE SUPPORT 
WEBSITE: SUPPORT.DRAKESOFTWARE.COM > 
TRAINING TOOLS > MANUALS.)

What’s New in Drake Tax for Corporations

Drake Tax is programmed to conform to the latest IRS rules and regulations. The 2019 
program reflects all changes to forms, credits, and deductions. For details on the new 
regulations for the 2019 tax year, see the IRS instructions for Form 1120.

The following changes have been made to the 1120 program in Drake Tax for the 
2019 tax year.

Drake Tax Changes for 2019

• The MISC screen, added to the Miscellaneous tab of the Data Entry Menu of 
the business packages, includes fields to help preparers keep up with the produc-
tion schedule of a return: Date promised, Date picked up, how much the client 
was charged last year (the 2018 prep fees field), and a check box for indicating 
clients who did not pay their bill last year. This is preparer information only and 
has no affect on the return.

• The Disaster Designation field on the MISC screen is for entering the name of a 
federally designated disaster for those business entities that incurred disaster 
losses and that are subject to federal disaster rules. An entry in this field is printed 

IMPORTANT

Some new IRS forms – and the Drake Tax screens 
used to complete these forms – had not been released 
in time for the publication of this supplement.When 
these forms are released, programmed, tested, and 
released, this manual will be updated and available on 
the Drake Support website, Support.DrakeSoft-
ware.com > Training Tools > Manuals.)

Be sure to review the 2019 Drake Tax User’s Manual – 
available from the Support.DrakeSoftware.com web-
site – for details on the changes to the tax program and 
practice management tools.
Tax Year 2019 9



What’s New in Drake Tax for Corporations Drake Tax Manual Supplement: 1120
across the top of the return but does not otherwise affect the return The field is 
limited to 75 characters (including spaces).

• An option to Update Misc Codes on Screen 1, available during the update pro-
cess (Last Year Data > Update Client 2018 to 2019) was added to the federal 
business packages. This option allows you to bring forward from 2018 the miscel-
laneous codes and drop lists you created last year. For more information on using 
these code fields, see “Miscellaneous Codes” in Chapter 5 of 2019 Drake Tax 
User’s Manual.

• The EF Notice will now be produced in View/Print mode for accepted 7004 exten-
sions.

IRS Changes for 2019

Some of the changes made to Form 1120 and to the Corporation package of Drake Tax 
for the 2019 tax season include:

• Dividends-Received Deduction (DRD) percentages have been reduced. The 80% 
DRD is reduced to 65%, and the 70% DRD is reduced to 50%.

• The corporate AMT (Form 4626) has been repealed for tax years beginning after 
2017. Screen 4626 in Drake Tax is for state use only.

• For tax years beginning after 2017, the corporate tax rate is a flat 21% rate. This 
rate affects Form 1120 and Form 1120-C filers. A homeowner association filing 
Form 1120-H will continue to be taxed at the same 30%-32% rate.

• Net Operating Loss (NOL) deduction: The general two-year net operating loss 
carryback rule does not apply to NOLs arising in tax years ending after 2017. 
Exceptions apply to certain farming losses and NOLs of property and casualty 
insurance companies.

New or Enhanced Forms and Screens for 2019

• Form 8990, Limitation on Business Interest Expense IRC 163(j). See “Business 
Interest Expense and Form 8990” on page 33

• Form 8992, U.S. Shareholder Calculation of Global Intangible Low-Taxed 
Income (GILTI). (In Drake Tax, screen I1 on the Foreign tab of the Data Entry 
Menu.)

• Form 8993, Section 250, Deduction for Foreign-Derived Intangible Income 
(FDII) and Global Intangible Low-Taxed Income (GILTI)

• Form 8997, Initial and Annual Statement of Qualified Opportunity Fund (QOF) 
Investments, along with the corresponding data entry screens. An investor in a 
qualified opportunity fund (QOF) uses Form 8997 to inform the IRS of the QOF 
investments and deferred gains held at the beginning and end of the current tax 
year.

• For more, see “Form 8997, Initial and Annual Statement of QOF Investments” on 
page 34.

• Form 8996, Qualified Opportunity Fund An investor in a qualified opportunity 
fund (QOF) uses Form 8997, Initial and Annual Statement of Qualified Opportu-
nity Fund (QOF) Investments, to inform the IRS of the QOF investments and 
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deferred gains held at the beginning and end of the current tax year, as well as any 
capital gains deferred and invested in a QOF and QOF investments disposed of 
during the current tax year. See See “Qualified Opportunity Funds” on page 35

• Form 965, Inclusion of Deferred Foreign Income Upon Transition to Participation 
Exemption (and appropriate schedules) See “Form 965, Deferred Foreign 
Income” on page 17

• Form 5471, Information Return of Persons with Respect to Certain Foreign Cor-
porations (and appropriate schedules). See “Foreign Tab” on page 53

• A Name Control field has been added to the EF screen. Use the Entity Name 
Control Override field only if your client has obtained a Name Control from the 
IRS.” See “Name Control” on page 51 for details.

Before You Start

Actions you might need to take before starting a 2019 corporation return in Drake Tax 
include:

• Updating a prior-year return (if you prepared the tax return last year in Drake Tax)

• Changing a return from another type of return to an 1120, if the corporation has 
made such a change in the last year

Updating a Prior-Year Return in Drake Tax

A prior-year return can be updated in one of three ways:

• As a single return (updated one at a time) using Last Year Data > Update Clients 
2018 to 2019 (Recommended)

• When you open a previous year’s return for the first time in the 2019 program and 
are prompted to update it

• With all other returns in the program using Last Year Data > Update Clients 
2018 to 2019 (Not recommended)

When you update an 1120 return that was marked “final” the previous year, the pro-
gram informs you that the return was marked final before prompting you to proceed.

Converting from Another Return Type

If the corporation is electing to become an 1120 corporation after existing as another 
type of entity (S corporation, partnership, etc.), it is necessary to indicate this in the 
program.

To change from another type of entity to an 1120 corporation in Drake Tax:

1. From the Home window menu bar, select Tools > File Maintenance > Change 
File Type to open the Convert Client Data File Type search window.

2. In the Client Selection text box, type the EIN or name of the entity. (You can also 
double-click the return from the Client Name list or click the Recent Returns 
drop list and then choose a category to help you search for a return.)
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3. Click Continue. 

4. Select the new return type.

5. Click Continue to save the change, then click OK.

Filing Form 1120-C or 1120-H

No preliminary steps are required for completing Forms 1120-H or 1120-C. Use the 
same screens you might for an 1120 return, but include one of the following screens in 
addition (accessible from the first Other Forms tab of the Data Entry Menu):

• H — For Form 1120-H, U.S. Income Tax Return for Homeowners Associations

• 20C — For Form 1120-C, U.S. Income Tax Return for Cooperative Associations

If one of these screens contains data, the program automatically produces the type of 
return indicated. For example, if a deduction is entered on screen 20C, an 1120-C 
return will be produced.

Header Information

Screen 1 contains fields for the general information printed in the top section of page 1 
of Form 1120 (or Form 1120-C or 1120-H, as applicable).

Name and Address

Use screen 1 to enter the corporation’s name and address for Form 1120. For state pur-
poses, if the corporation has an alternate address (such as a P.O. box), you can enter 
that address on screen 2, State General Information, in the Address Line 2 field at 
the bottom of the screen. Click the State Info link on screen 1.

Doing
Business As

Anything typed into the DBA field of screen 1 will be printed below the legal name of 
the corporation in the “Name” section of the main form (and on certain other forms, 
such as Form 8821, Tax Information Authorization, and Form 2848, Power of Attor-
ney).

Use of the DBA field is optional and data entered there is not required by the IRS. It is 
provided in the program for the return preparer’s convenience.

Continuation 
Line

The DBA field can also serve as a “continuation” line for entity names that are too 
long to fit into the legal name field. Be aware, however, that not all federal forms 

TIP
Is Form 1120-C or 1120-H being produced in error? Check the corre-
sponding screen (H or 20C) for data entered. To delete a screen, either 
open the screen and press CTRL+D, right-click the screen and select 
Delete Screen, or from the data entry screen toolbar, select Delete.

NOTE The screen 2 link is located on the States tab of the Data Entry Menu. 
You can also type 2 into the selector field and press ENTER.
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accept data from a continuation (or DBA) line. For those forms, only the data entered 
in the legal name field is used.

Tax Year

The program uses the calendar year as the default tax period for all corporation 
returns; no date entries are required on screen 1 for a December 31 tax year end.

Fiscal and 
Calendar 

Years

If the corporation uses a fiscal year (where the year begins in the current calendar year 
and ends in the next), specify the beginning and ending dates in the If not calendar 
year section in the lower left corner of screen 1.

Short-Year 
Returns

A corporation might have to file a short-year return if it is changing accounting peri-
ods with IRS approval (Form 3115), or if this is its first or last year in business and the 
tax year is not a full year.

Short-year return election information and 52-53-week tax year information is entered 
on the Year screen, available on the Miscellaneous tab of the Data Entry Menu or 
from a Year link on screen 1. (Certain other elections are made from the ELEC 
screen.)

To enter short-year election information:

1. Enter short-year dates on screen 1 in the Fiscal year begins and Fiscal year ends 
fields, even if the firm uses the calendar year for full-year returns. These dates 
appear on the top of the federal form.

2. Click the Year link to open the Year screen.

3. Make your short-year selection from the Other short-year reason drop list. Your 
explanation is displayed at the top of the first page of the tax return. If you do not 
select an explanation, an EF Message is generated with the return, and the return 
cannot be e-filed.

If you selected “09 General Explanation” from the Other short-year reason drop list, 
type details on the reasons for filing a short-year return in the Explanation text box; 
otherwise, an EF Message is generated.

NOTE Not all states recognize the use of a DBA. Those state packages ignore 
data entered in the DBA field.

NOTE
The program adjusts calculations for depreciation and for gains and 
losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53–week year, see “Electing a 52-
53–Week Year (Initial Return)” on page 51.

NOTES
For more information on short-year explanations, see IRS Pub. 4163.

The program may not correctly calculate depreciation, gains, or 
losses for a short-year return. Depreciation for a short-year return can 
be entered on screen 4562 and screens 6, 7, 8, and 9.
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Boxes A through E

Use screen 1 to enter most information for boxes A through E (top of Form 1120). 
Note that boxes A-4 (“Schedule M-3 attached”) and D (“Total assets”) are completed 
automatically by the program based on data entered elsewhere.

Optional (but Recommended) Security Information

Screen code: SEC The Filing Security Information screen in Drake Tax is part of an industry-wide ini-
tiative to better protect taxpayers and return preparers from data theft and tax fraud. 
The information entered on the SEC screen is transmitted when the tax return is 
e-filed. Completing this screen for federal returns is strictly optional for 2019; how-
ever, certain states will begin requiring this information in the near future.

The Filing Security Information (SEC) screen is accessible through the Filing Secu-
rity Information link on screen 1 or from the Data Entry Menu.

Income and Deductions

Only three screens are required in order to calculate taxable income for an 1120 
return:

• INC — Includes all items of income reported on Form 1120, page 1, lines 1 
through 10, that do not require a separate schedule (Schedule C) or additional 
information (income reported on screen K1P (Form 1065, Schedule K-1)); also 
includes tax-exempt interest income reported on Schedule K (Amounts entered in 
this field flow to Schedule K, line 9, and Schedule M-1, line 7, or Form 8916-A, 
Part II, line 1.)

• DED — Includes all deduction items reported on Form 1120, page 1, lines 13 
through 26, that do not require a separate schedule or form (Form 4562). (Data for 
line 12 of the 1120, “Compensation of officers,” is generally entered on screen 
DED when Form 1125-E is not required; otherwise, compensation of officers is 
entered on screen E. See “Compensation of Officers (Form 1125-E)” on page 19 
of this document for details.)

• J — Includes loss carrybacks, controlled group tax bracket amounts, tax payment 
information, and certain credits.

Gross Receipts

Enter gross receipts (Form 1120, line 1a) and returns and allowances (Form 1120, line 
1b) on lines 1a and 1b of the INC screen. Exclude any amounts that are to be reported 
on lines 4 through 10 of Form 1120.

NOTE
Box 1a (“Consolidated return”) in section “A” is automatically marked 
if there are entries on screen 851 (Form 851, Affiliations Schedule). 
Box 2 (“Personal holding company”) in section “A” is automatically 
marked if there are entries on screen PH (Schedule PH, U.S. Per-
sonal Holding Company (PHC) Tax).
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Cost of Goods Sold (Form 1125-A)

Enter the cost of goods sold (COGS) on screen A (click the Screen A link on the INC 
screen, or the A link from the Data Entry Menu). Form 1125-A is not produced 
unless entries are made on screen A. 

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3 (“Inventories”).

Line 5, Other 
Costs

In Drake Tax, two data-entry fields are used to complete line 5, “Other costs,” on 
screen A (figure below) for any applicable costs not entered on lines 2, 3, or 4 (pur-
chases, cost of labor, and additional section 263A costs): one for other costs excluding 
depreciation, and one for depreciation.

In the “Deprecia-
tion” field, enter 
any depreciation 
that relates to the 
cost of goods sold 
(unless the 
amount is flowing 
from the 4562 
screen with 
COGS selected 
from the For drop 
list). Note that 
this field of 
screen A is an 
override field; an 
entry here overrides calculations from the 4562 screen and automatically adjusts the 
total depreciation that flows to page 1 of Form 1120.

An entry in the “Other costs - excluding depreciation” field of line 5 opens a Detail 
Worksheet (also known as a CTRL+W worksheet). The program automatically gener-
ates a worksheet if an entry is made here or in any other field where a worksheet is 
required by the IRS. The depreciation amount is included on the statement for other 
costs and should not be included in the “Other costs - excluding depreciation” field.

Importing 
Trial Balance 

to Sch A

If using the trial balance import feature, enter depreciation amounts directly into the 
appropriate fields on the trial balance worksheet, not in the fields in Drake Tax data 
entry. When the trial balance is imported, the COGS depreciation expense amount

NOTES

Lines 1, 2, and 7 of screen A are adjustment fields. Amounts 
entered in these fields adjust (add to or subtract from) any amount 
flowing from the F screen (Form 1040, Schedule F, Profit or Loss 
from Farming) to line 2 of Form 1120.

On both of the Schedule L screens – L and L2 – line 3, “Invento-
ries,” is an override field. Anything entered in these fields overrides 
(replaces) the total calculated from inventory data entered on 
screen A.
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flows directly to the appropriate line of Form 1125-A and is calculated accordingly.

See “Importing Trial Balance Information” on page 58.

Dividends (Schedule C)

Enter dividends, certain inclusions, and special deductions on screen C (Schedule C). 
The Dividends Received Deduction Worksheet (Wks DRD) is generated from data 
entered in these fields. The result of the Wks DRD is carried to Schedule C of the 
return. The total from Schedule C, line 23, column (a), is included on line 4 (“Divi-
dends and inclusions”) of Form 1120, and the total from Schedule C, line 24, column 
(c), flows to Form 1120, line 29b (“Special deductions”).

Foreign Income-Sourced Income and Dividends

Use lines 13 and 14 of screen C to report foreign-sourced dividends. Line 15 is an 
override field; use this field if you wish to override the calculated 2019 section 965(a) 
inclusion amount from Form 965.

Line 13 Enter on line 13 the foreign-source portion of dividends that both:

• Are received from specified 10% owned foreign corporations, including gain 
from the sale of stock of a foreign corporation that is treated as a dividend for the 
purposes of applying section 245A under sections 128(a) and (j)

• Qualify for the 100% deduction under section 245A excluding any hybrid divi-
dends

Line 14 Include on line 14 any hybrid dividends from a controlled foreign corporation (CFC) 
dividends not reportable on lines 3, 6, 7, 8, 11, 12, or 13. Hybrid dividends generally 
are dividends from a CFC that would otherwise be reported on line 13 except that the 
CFC receives a deduction (or other tax benefit) with respect to any income, war prof-
its, or excess profit taxes imposed by any foreign country or possession of the U.S.

Also include on line 14 the corporation's share of distributions from a section 1291 
fund from Form 8621, to the extent that the amounts are taxed as dividends under sec-
tion 301. See Form 8621 and the instructions for Form 8621 for details.

Line 15 Use this line to override the Section 965(a) inclusion amount from Form 965 calcu-
lated by the program and flowing from line 3 of Form 965. Complete and attach Form 
965 and any applicable schedules, and Form 965-B. Enter in column (c) the 2019 sec-
tion 965(c) deduction amount from Form 965, line 17. An entry in this field overrides 
the amount flowing from Form 965.

NOTE If the corporation is filing a consolidated return, do not enter 
non-included dividends here or anywhere else in the program.
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Form 965, Deferred Foreign Income

Taxpayers who own (directly or indirectly) certain foreign corporations, may have to 
include on their 2018 tax return certain deferred foreign income. In general, U.S. 
shareholders must pay a transition tax on the untaxed foreign earnings of certain 
specified foreign corporations as if those earnings had been repatriated to the United 
States.

Interest

Line 5 of Form 1120 is for interest income, which is entered on the INC screen. Note 
that the Interest income field on the INC screen is an adjustment field; an amount 
entered there is combined with the interest amount, if any, entered on screen 6252 
(Form 6252, Installment Sale Income) and interest income entered on screen K1P 
(Schedule K-1, Form 1065).

Enter tax-exempt interest income on the INC screen. This amount flows, as applica-
ble, to Schedule K, line 9, and to Schedule M-1, line 7. An override field is available 
on screen K if necessary to override the INC screen amount and any amount flowing 
from screen K1P, line 18, code “A.”

Rents and Royalties

Enter gross rents and gross royalties using the direct-entry fields on the INC screen. 
Line 7, “Gross royalties” is an adjustment field. Any amount entered here adjusts 
amounts flowing from line 7 of screen K1P.

Note that passive activity loss rules may be applied to rental activities held by a 
closely held corporation or a personal service corporation.

Capital Gains

Screen code: 8949 Use screen 8949 to enter capital gains and losses. Short-term capital gains flow to Part 
I, lines 1b, of Schedule D. Long-term capital gains flow to Part II, lines 8b-9, of 
Schedule D. The net gain from Schedule D is carried to line 8 of Form 1120. (Any net 
capital loss is carried to Attachment D to offset future gains.)

NOTE
As of publication of this manual, the IRS had not released its final ver-
sion of Forms 951A and 965; thus, the screens are inactive in Drake 
Tax.

These screens will be activated with an update when the IRS releases 
its forms at the release date of this manual.

NOTE
You can import data for Schedule D using the Form 8949 Import fea-
ture. For more on using this feature, see “Form 8949 Imports” in Chap-
ter 5 of the 2019 Drake Tax User’s Manual.
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Ordinary Gains and Losses

The amount generated for line 9 of Form 1120 flows from Form 4797, Part II, line 17. 
Amounts can also flow from screen 4562 to Form 4797 (making screen 4797 entries 
unnecessary), but only if screen 4562 shows assets sold, date, and property type.

Other Income (Loss)

Use the INC screen to enter amounts for the “Other income” line of the main form. 
Specific INC screen entries are displayed on attached statements in View/Print mode 
(Figure 1).

Figure 1: Statement containing “Other Income” entries from INC screen

Additional fields for other income on the INC screen include:

• Amount of credit for tax on fuels

• Interest income on receivables

• Recoveries of bad debts

• Section 481 adjustments

• State tax refund

• Taxable income from insurance proceeds

• Other (itemize) (Detail worksheet is required)
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• Ordinary income from partnerships (See Notes, below)

Compensation of Officers (Form 1125-E)

Form 1125-E, Compensation of Officers, is not generated automatically with the 
return unless it is required—in other words, unless total receipts (line 1a, plus lines 4 
through 10) on Form 1120 are $500,000 or more. To force the program to print Form 
1125-E, from the PRNT screen, select Force Form 1125-E, Officer Compensation.

 Officer 
Information

Use screen E to enter officer information and compensation amounts. Press PAGE 
DOWN to enter additional officers. Screen E totals are calculated and carried to line 12 
of Form 1120.

The total of officer compensation can be entered in the Officer compensation over-
ride field on the DED screen (generally used when Form 1125-E is not required). An 
entry in that field overrides any calculations from screen E, changing lines 12 and 27 
of Form 1120, but it does not change the numbers on Form 1125-E.

Screen E 
Check Boxes

Screen E has two check boxes: Signs return and Books in care of. Mark the applica-
ble box on the screen that identifies the officer who either signs the federal or state 
paper returns or is the contact person for the books (state return only).

NOTES

• Data from Schedules K-1 received from partnerships should be 
entered on the K1P screen. (Click the K1P Screen link on the “Ordi-
nary Income from Partnerships” line of the INC screen or click the 
K1P link located on the first Other Forms tab of the Data Entry 
Menu.) 

• Certain “extender” tax credits have been revived for 2019. In fact, 
these extenders are retroactive, so taxpayers who were unable to 
claim these credits in 2018 are now eligible for to file amended 
returns.

• Amounts from the following screens again flow to line 10 of Form 
1120:

– 6478 (Form 6478, Biofuel Fuels Credit)

– 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels 
Credit)

– 8844 (Form 8844, Empowerment Zone and Renewal Commu-
nity Employment Credit)

– 8845 (Form 8845, Indian Employment Credit)

TIP
You may “truncate” the officer’s Social Security Number in the ID num-
ber field of screen E. To do so, enter five zeros (“00000”) and then the 
last four digits of the SSN. You must press CTRL+F to “force” the pro-
gram to accept the truncated number.

IMPORTANT
Neither “FOREIGNUS” nor “APPLD FOR” is acceptable in 
the ID number field. Returns with “FOREIGNUS” or 
“APPLD FOR” in this field are not eligible for e-file.
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Ownership & 
Participation

The Ownership and Participation fields on screen E are required. Fields are as fol-
lows:

• Total — Enter the officer’s ownership percentage.

• Common — Enter the percentage of common stock owned by the officer.

• Preferred — Enter the percentage of preferred stock owned by the officer.

• Time — Enter the percentage of time the officer devotes to the corporation.

Enter percentage amounts in whole numbers. For example, enter 40 for 40%

Salaries and Wages

Use the DED screen to enter salaries and wages paid. Note that the “Salaries and 
wages” field on the DED screen is an adjustment field; an amount entered here adjusts 
any amount entered on screen F (Form 1040, Schedule F, Profit and Loss from Farm-
ing) in the “Labor hired” field. Also note that the amount entered on screen DED is 
reduced on line 13 of Form 1120 by the amount, if any, of credit from Form 5884. 

Repairs and Maintenance

Enter repair and maintenance costs on the DED screen. An amount entered here is 
combined with the amount, if any, entered in the Repairs and maintenance field on 
screen F.

Bad Debts

Use the “Bad debts” line on the DED screen to enter the total debts that became 
worthless in whole or in part during the year, but only to the extent that such debts 
related to a trade or business activity.

Rents

Enter rent paid on business property used for a trade or business activity on the DED 
screen. If the corporation rented or leased a vehicle, enter the total annual rent or lease 

NOTE
The “Salaries and wages” amount should not include compensation of 
officers. Enter officer compensation data either on screen E or as “Offi-
cer Compensation” on line 12 of the DED screen.

NOTE
Enter deductible non-business bad debts as a short-term capital loss on 
screen 8949 (Capital Gains & Losses).

Cash method corporations cannot take a bad debt as a deduction 
unless the amount was previously included in income.
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expense incurred in the trade or business activity of the entity, and then complete Part 
V of the 4562 (screens 8 and 9).

Taxes and Licenses

Enter tax and license amounts in the Taxes and licenses section of the DED screen. 
Click the Detail link to list the various sources of taxes and licenses. Amounts are 
combined and the sum generated on Form 1120, line 17 (“Taxes and licenses”).

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen flow to the tax computation worksheet (Form 1120-W). The state tax amount 
flowing from the ES screen may differ depending on which method of accounting 
(cash or accrual) is used.

Interest Expense

Enter interest expense on the DED screen. Note that the Interest expense field is an 
adjustment field. Any amount entered here is combined with the amount, if any, 
entered in the Interest fields on screen F. 

Charitable Contributions

The DED screen provides two fields for entering data for line 19, “Charitable contri-
butions” (figure below):

•   Contributions — 
Enter the gross amount 
of contributions for the 
year that are subject to 
the 10% limit on deduc-
tion.

•   Qualified conserva-
tion contributions — Enter the gross amount of contributions for the year that are 
not subject to the 10% limit. These contributions have a carryover period of 15 
years; see IRS instructions for details.

The program calculates the contributions allowed and determines carryover capability 
for amounts entered in both fields for line 19 and reflects the applicable amount on 
Form 1120. (Refer to the Contribution Limitation/Carryover Worksheet (“Wks Con-

NOTE
The Rents field is an adjustment field. An amount entered here is com-
bined with the amount, if any, entered in the Rent fields on screen F, 
lines 24A and 24b.

NOTE
These amounts also appear on the Taxes and Licenses Attachment 
(“Wks Tax/Lic”). To keep the notification from appearing, go to the 
PRNT screen (accessible from the General and the Miscellaneous 
tabs of the Data Entry Menu) and select Suppress printing form and 
attachment references.
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trib”) for calculation of allowed amount.) Contribution carryovers from prior years are 
entered on the LOSS screen.

Note that both fields of line 19 of the DED screen are adjustment fields; entries here 
adjust amounts flowing from screen K1P, line 13, codes A and B.

Depreciation

Enter depreciation on the 4562 screen. Select a form from the For drop list (Figure 2) 
to associate the depreciable item with the correct form or activity. Data from the 4562 
screens flows to Form 1120 and to the selected schedules or forms.

Figure 2: Selecting “1120” from the For drop list of the 4562 screen

Depletion

Enter depletion deductions on the DED screen. Data entered flows directly to page 1 
of Form 1120. See Form 1120 instructions and Pub. 535 for more information on 
depletion.

If the corporation claims a deduction for timber depletion, attach Form T (Timber), 
Forest Activities Schedule, available for the irs.gov website. 

IMPORTANT: Do not enter depletion for oil and gas properties on this line. Oil and 
gas depletion should be entered on the DEPL screen.

Oil and Gas 
Depletion 

Worksheet

The DEPL screen is accessible from the first Other Forms tab of the Data Entry 
Menu. Create a separate depletion worksheet for each oil or gas interest. (Press PAGE 
DOWN to open a fresh instance of the DEPL screen.) Enter data for cost depletion, 
percentage depletion, or for both. If data for both cost and percentage depletion is 
entered, the program does both computations and sends the one that gives the corpora-
tion the best deduction to the proper form or schedule. (Not all corporations have the 
option of using either method. Consult Publication 535 for additional information.)

Screen Code: 
DEPL

Entries on the DEPL screen flow to the Oil and Gas Depletion Worksheet (“Wks 
DEPL” in View/Print mode).

NOTE
For more on the For drop list in Drake Tax, see “Associating One 
Screen with Another,” in Chapter 3 of the 2019 Drake Tax User’s 
Manual
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Advertising

Enter advertising expenses on the DED screen.

Pension and Profit-Sharing

An entry on the “Pension, profit sharing and other plans” line of the DED screen 
adjusts an amount entered on screen F (Schedule F, Profit or Loss from Farming) and 
reduces this expense based on the credit amount calculated from Form 8881, Credit 
for Small Employer Pension Plan Startup Costs. The total flows to line 23 of Form 
1120.

Employee Benefits

Contributions to employee benefits programs not claimed elsewhere on the return that 
are not an incidental part of any plans are entered in an adjustment field on the DED 
screen. An amount entered on this field adjusts the amount flowing from Schedule F, 
Profit or Loss from Farming.

Domestic Production Activities

The Domestic Production Activities Deduction (DPAD) has been repealed for tax 
years beginning after 2017, with limited exceptions.

Other Deductions

Enter all other deductions on the DED screen. The program calculates these amounts 
and incorporates the total into line 26 (“Other deductions”) of Form 1120. The follow-
ing deductions, credits, adjustments, and exclusions also flow to line 26:

• Amortization from Form 4562

• Credit from Form 8820, Orphan Drug Credit

• Exclusion from Form 8873, Extraterritorial Income Exclusion

• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

NOTE
A taxpayer is eligible for the DPAD on the federal 1120 return only if the 
deduction is passed through from a fiscal-year corporation with a tax 
year that began in 2017. If the DPAD is not from a pass-through fiscal-
year entity, complete screen 8903 only if it is needed on the state 
return.

NOTES
Drake Tax automatically calculates meals and entertainment limita-
tions.

A Detail Worksheet is opened when you type an amount in the 
“Other (itemize)” field of the DED screen.
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NOL Carrybacks and Carryforwards

Screen Code: J Enter NOL carrybacks from future years to the current year on screen J (Loss Carry-
back, Tax Computation, Payments). To enter multiple carryback amounts, double-
click in the field to open a Detail Worksheet.

Screen Code: 
LOSS

Use the LOSS screen to enter NOL carryforwards, capital losses, and contribution 
carryforwards from prior years. Use screen J to enter current-year carrybacks to prior 
years.

Tax, Refundable Credits, and Payments

Screen J has fields for completing the “Tax, Refundable Credits, and Payments” sec-
tion of Form 1120. Note that some fields are overrides. Click in a field and press F1 to 
view more information on a field.

Total Tax

For corporations that belong to a controlled group, complete all applicable fields on 
screen J. If allocating income to the various brackets on this screen, you must enter 0 
(zero) in the fields of the brackets to which no income is allocated.

The total tax from Schedule J is calculated and carried to line 31 of Form 1120.

Schedule O

A corporation that is a component member of a controlled group uses Schedule O, 
Consent Plan and Apportionment Schedule for a Controlled Group, to report the 
apportionment of certain tax benefits among members of the group. Schedule O is also 
used to indicate that the member filing this return consents to and represents that all 
the other component members of the controlled group.

In Drake Tax, data entry screens O and OM, used to complete Schedule O, are located 
on the Controlled Group Information section of the first Other Forms tab of the 
Data Entry Menu.

Form 3800

Use screen 3800 to claim current-year business credits that are not supported by Drake 
Tax. (Returns with these current-year credit forms that are not supported by Drake Tax 
must be paper-filed.)

Screen code: 3800 In Part III - General Business Credits, enter the amounts of nonpassive and passive 
activities of the unsupported credits.

NOTE Schedule O is an informational form only and does not change any cal-
culations in the return. 
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Enter any unused current-year credit being carried back and used in 2018 in the 
Amount of Carryback text box on screen 3800.

Carrybacks 
and Carry-

forwards

Use screen GBC for reporting general business credit (GBC) and eligible small busi-
ness credit (ESBC) carrybacks and carryforwards, and to enter passive activity credit 
carryforwards for Form 8582-CR.

Screen code: GBC Passive activities credit carryforwards are updated to screen GBC.

To use the GBC screen:

1. Mark an appropriate check box at the top of screen GBC.

2. If appropriate, enter an EIN in the Activity EIN field; if that EIN matches one 
entered on a K1 screen, the program matches the passive activity carryforward to 
the current-year credit for Form 8582-CR.

3. Enter the Activity Name.

4. From the Description of credit drop list, select the description of the credit for the 
amounts being carried forward from prior years or being carried back from a 
future year. If necessary, enter the Amount Changed Information if the amount 
was changed from the original amount of the credit.

5. From the Year Originated drop list, select the year the credit was originally gen-
erated and the amount of the credit for the year generated. 

Press PAGE DOWN to enter the carryforward or carryback amounts of another credit.

Estimated Taxes and Applied Refunds

Screen code: ES Enter on screen ES (available on the Miscellaneous tab) the estimated corporation 
taxes paid. If necessary, use screen W to override 2019 estimated taxes paid and apply 
any overpayments from 2019 to 2020. (Click the Screen W link at the top of the ES 
screen to open the W screen.)

NOTES

• Pass-through credits from those unsupported forms are supported 
by Drake Tax. Enter these pass-through credits on screen K1P. 
Enter carryforwards on screen GBC.

• To enter data for credits that are supported by Drake Tax, use the 
credit’s screen. For example, use the 8820 screen for Form 8820, 
Orphan Drug Credit.

TIP
In the Amount of Original Credit Previously Used section of screen 
GBC, type in the amounts of credit carryforward used in a previous 
year for a true historical record. The program computes the remaining 
amount of the credit each year you use Drake Tax.

NOTE Estimate vouchers are not used in federal corporation tax returns.
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Over- 
payment

Overpayments are not automatically applied unless 2020 estimates are being calcu-
lated. If no estimates are required, enter the application of the overpayment using the 
Overpayment applied override fields.

Quick 
Refund

To file Form 4466, Corporation Application for Quick Refund of Overpayment of 
Estimated Tax, go to the PRNT screen (accessible from the General and the Miscel-
laneous tabs of the Data Entry Menu) and mark the Calculate Form 4466 box. This 
is the only entry necessary to produce the form. (There is also a link to the PRNT 
screen from the first Other Forms tab of the Data Entry Menu. Click 4466 Applica-
tion for Quick Refund.)

Under-
payment

Use screen 2220 (available from the first Other Forms tab of the Data Entry Menu) 
to enter information for Form 2220, Underpayment of Estimated Tax by Corporations. 
Note that the 2220 screen in Drake Tax consists of two screens. Press PAGE UP and 
PAGE DOWN to move back and forth between the screens.

Estimated State Taxes

Enter 2019 estimates and 2020 overpayments for state or city returns on the ES 
screen.

The ES screen also provides a way to e-file state estimated tax vouchers and pay-
ments, which is required in some states. For estimated taxes from multiple states or 
cities, press PAGE DOWN and go to a new ES screen.

For details on using the ES screen to file federal estimated taxes, and to e-file and pay 
state estimated taxes, see “Estimated Taxes,” in Chapter 5 of the 2019 Drake Tax 
User’s Manual.

Direct Deposit of Refunds

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submit-
ted with an e-filed return in order for a corporation’s refund to be direct-deposited. To 
access this form in Drake Tax, go to the DD screen, accessible from the General tab 
of the Data Entry Menu.

Screen Code: DD When filling out the DD screen:

NOTE The program retains the underpayment and penalty rates as of 
12/31 of the calendar year.

NOTES

If you are not filing four quarterly state vouchers—for instance, if filing 
too late to pay first quarter payment—the program adds the amount of 
the missed payment to the next available voucher. Enter “0” in the Esti-
mate amount voucher field for the quarter the payment was not made.

The Increase/Decrease calculated estimates by... text box on the ES 
screen allows you to adjust the total estimated taxes due.
26 Tax Year 2019



Drake Tax Manual Supplement: 1120 Electronic Funds Withdrawal (Direct Debit)
• If the federal refund is to go to the account listed, select Yes for the Federal selec-
tion drop list; otherwise, select No. (Default is Yes.)

• If a state refund is to go to the account listed, select the state abbreviation from the 
State/city selection drop list.

• Enter the name of the financial institution, the routing number (RTN), the account 
number, and the type of account (Checking or Savings).

• Re-enter the routing number, account number, and type of account to verify 
(Figure 3).

Figure 3: Federal section of DD screen (also 8050 screen)

If receiving refunds from different state tax authorities, use the State Account boxes 
on the DD screen to indicate where other state refunds should be deposited.

Electronic Funds Withdrawal (Direct Debit)
Screen Code: 
PMT

Use the PMT screen, accessible from the General tab, to indicate that the balance due 
for an e-filed return should be withdrawn (direct-debited) from an account.

Program Defaults and Overrides

By default, the program indicates that the entire balance due (line 35, “Amount 
owed,” of Form 1120) is to be withdrawn on the return due date. To indicate other-
wise, complete the Requested payment date override fields (see the blue square in 
Figure 4 on page 28) for the applicable payment. If the return is e-filed on or before 
the due date, the requested payment date cannot be later than the due date. If the return 
is transmitted after the due date, the requested payment date cannot be later than the 
date the return is transmitted.

Required Information

A Withdrawal selection (item #1 in Figure 4 on page 28) is required if the program is 
to direct tax authorities to withdraw funds from the corporation’s bank account.
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Figure 4: Required fields on PMT screen: withdrawal selection (1); account information (2); 
specified return (3). The blue square is for the optional payment date override.

The name of the financial institution, RTN, account number, and account type are 
required. As with the DD screen, the RTN, Account number, and Type of account 
data must be entered twice on the PMT screen (item #2 in Figure 4).

Finally, the PMT screen must indicate the return to which the payment data applies 
(item #3 in Figure 4). Mark the box of the applicable return type: 1120, 7004, or 
1120X.

Withdrawal from Multiple Accounts

Only one account can be designated for direct debit of funds for payment of federal or 
state taxes. To have state amounts withdrawn from an account other than the account 
indicated for federal payments, complete the fields in the State Account sections of 
the PMT screen.

Filing an Extension

Calendar-year returns are due on April 15, 2020. Fiscal-year returns are due on the 
15th day of the fourth month after the end of the corporation’s business year for corpo-
rations with other than a June 30 ending date; corporations with an ending date of June 
30 must file their returns by the 15th day of the third month after the end of their busi-
ness year.

By filing Form 7004, a corporation can extend the deadline. The 7004 extends the 
deadline six months to October 15 (seven months for corporations with June 30 end-
ing dates).

Use one of the following options to file an extension for an 1120, 1120-C, or 1120-H:

• Go to the 7004 screen in Drake Tax (available from the second Other Forms tab) 
and select Generate an extension. Complete any other applicable fields on the 
screen.

NOTE Neither the federal nor the state balance due can be paid from more 
than one account.
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• Go to the PRNT screen and select Prepare Form 7004 extension based on 
screen 1 info.

Signing the Return

Electronic PIN signatures are required for e-filed returns. To e-file a return, complete 
all fields on the PIN screen. A return cannot be e-filed if the PIN screen fields, includ-
ing the title and signature (name) of the officer signing the return, are not complete. 

Screen Code: PIN An 1120 return must be signed and dated by one of the following individuals:

• The corporation’s president, vice president, treasurer, assistant treasurer, or chief 
accounting officer

• Any other corporation officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required 
information and “sign” the return (enter his or her PIN) in the space provided on the 
PIN screen. If it is prepared by an employee or officer of the corporation, go to screen 
1 and select NONE in the Firm # and Preparer # drop lists.

To have the preparer’s name and address information displayed on the printed return:

• If the return preparer and ERO (entered in Setup > ERO & Account Informa-
tion) are the same:

– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.

– Complete the PIN screen for the return.

• If the return preparer and ERO are not the same:

– Go to the PRNT screen for the return and complete the field labeled PIN for 
preparer’s alternative electronic signature. The PIN entered should match 
the one entered for the preparer in Setup > Preparer(s). (For more informa-
tion, press F1 in this field.)

NOTE
Setup > ERO & Account Information must still be completed in 
Drake Tax to e-file returns. For information on how to complete this 
setup window, see 2019 Drake Tax User’s Manual. See the IRS 
instructions for further details on signature requirements.

TIP
If you mark the “Signs return” check box on screen E, that officer’s 
information flows to the signature line of the return so you won’t have to 
reenter it on the PIN screen. You will still have to enter an officer’s PIN 
and signature date on the PIN screen for e-file.
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Amending a Return

The program can automatically fill the 1120X screen for Form 1120X, Amended U.S. 
Corporation Income Tax Return.

Returns 
Previously 

Prepared in 
Drake Tax

From the Data Entry Menu of an 1120 return, enter X in the selector field and press 
ENTER. (Screen X is also accessible from the first Other Forms tab.) At the prompt, 
select Yes to automatically fill the screen with data from the original return (that is, the 
return as originally entered in Drake Tax). If the corporation’s name or address infor-
mation has changed, enter the new information on screen X. Make all other necessary 
changes to the regular data entry screens.

Select screen X2 from the first Other Forms tab (or press PAGE DOWN while in 
screen X). Enter the line number from the X screen that corresponds with the changes 
that were made in data entry. (For instance, if you made a change in the tax on screen 
J, enter 4 (for line 4, “Tax,” of the X screen) in the Line Number field of the X2 
screen.) Enter an explanation in the Explanation of changes text box.

If more than one item was changed in data entry, press PAGE DOWN to open another 
screen X2. Enter the line number from screen X that corresponds to this change and 
enter another explanation.

When you go to View/Print mode, the program calculates the amended return.

New Returns To amend a return not previously prepared in Drake Tax, create an 1120 return in 
Drake Tax and open screen X. Complete the applicable fields on this screen, and then 
enter the amended data in the appropriate other screens, as described in the following 
example.

Example: An 1120 return was filed using a different tax program, but gross rental 
income was not reported on line 6 of the return. To amend the return:

1. Create an 1120 return in Drake Tax and complete all necessary screens.

2. From the Data Entry Menu of the return, open screen X.

3. Complete all applicable fields on screen X.

4. Close screen X and open the INC screen.

5. Enter the amount of unreported income on line 6, “Gross rents.”

6. Close the INC screen and open screen X2.

7. Enter the line number from the X screen that corresponds to the changes that were 
made in data entry. (In this instance, since you made a change to income on the 
INC screen, enter 1 (for line 1, “Total Income, on the X screen”) in the Line 
Number field of the X2 screen.

8. Enter an explanation in the Explanation of changes text box.

CAUTION

When you amend a return in Drake Tax, the amended informa-
tion replaces the original in the data file. Before amending a 
return, you should archive the original to avoid losing previ-
ously submitted data. For more information on archiving 
returns, see “Archive Manager” in Chapter 6, “Return Results,” 
of the 2019 Drake Tax User’s Manual.
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9. Calculate and view the return. Note the adjustments made on Form 1120X.

e-File an 
Amended 

Return

To add Form 1120X to the queue for e-file, go to the EF screen for the return (accessi-
ble from the General tab of the Data Entry Menu) and mark the 1120-X box. For 
detailed instructions on e-filing the returns in the queue, see Chapter 8, “e-File,” in the 
2019 Drake Tax User’s Manual.

Schedule K

Use screen K to enter data for Schedule K, Other Information. Screen K should also 
be used for Schedule K of Form 1120-C. Detailed here are some specific areas that 
might need your attention.

Schedule K, Line 3

On line 3 (line 5 of the 1120C column) of screen K, type the EIN and name of the par-
ent corporation if the corporation is a subsidiary in an affiliated group or a parent-sub-
sidiary controlled group.

Be aware of the following guidelines from the IRS:

• If the corporation is an “excluded member” of a controlled group (see definition in 
the Instructions for Schedule O (Form 1120)), it is still considered a member of a 
controlled group for this purpose.

• An affiliated group is one or more chains of includable corporations (section 
1504(a)) connected through stock ownership with a common parent corporation. 
The common parent must be an includable corporation and the following require-
ments must be met:

– The common parent must directly own stock that represents at least 80% of 
the total voting power and at least 80% of the total value of the stock of at 
least one of the other includable corporations.

– Stock that represents at least 80% of the total voting power and at least 80% 
of the total value of the stock of each of the other corporations (except for the 
common parent) must be owned directly by one or more of the other includ-
able corporations.

– For this purpose, the term “stock” generally does not include any stock that 
(a) is nonvoting, (b) is nonconvertible, (c) is limited and preferred as to divi-
dends and does not participate significantly in corporate growth, and (d) has 
redemption and liquidation rights that do not exceed the issue price of the 
stock (except for a reasonable redemption or liquidation premium). See sec-
tion 1504(a)(4). 

Schedule K, Line 4

If a corporation owned, directly or indirectly, 20 percent or more, or owned, directly 
or indirectly, 50 percent or more of the total voting power of all classes of the corpora-
tion’s stock entitled to vote, the applicable data appears on Schedule G. In Drake Tax, 
Schedule G data is entered on screens G1 and G2, accessible through the G1 Screen 
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and G2 Screen links on line 4 of screen K, or from the General tab of the Data Entry 
Menu.

Screen Codes:
G1 and G2

If the stock is owned by any foreign or domestic corporation, partnership, or trust, 
enter on screen G1 the name and EIN of the entity, the type of entity (foreign or 
domestic corporation, partnership, trust, etc.), the country of the corporation organiza-
tion, and the percentage of stock the entity owns.

If the stock is owned by an individual or estate, enter on screen G2 the name and ID 
number of the individual or estate, country of citizenship, and percentage of stock 
owned. 

Use the CTRL+PAGE DOWN function to open additional (blank) G1 or G2 screens. For 
more information on line 4 of Schedule K, see the IRS instructions.

Schedule K, Line 5

If the corporation owned stock in other corporations or partnerships or the beneficial 
interest in a trust, enter the information on the K5A or K5B screen. Click the K5A 
Screen or K5B Screen links on the K screen or from the General tab of the Data 
Entry Menu to access fields for entering this information.

Screen Codes: 
K5A and K5B

Use the CTRL+PAGE DOWN function to open additional (blank) K5A or K5B screens. 
For more information on line 5 of Schedule K, see the IRS instructions.

Schedule K, Line 7

Complete the fields on line 7 of screen K if a foreign person owned, directly or indi-
rectly, at least 25% of the total voting power of all classes of the corporation’s stock 
entitled to vote, or the total value of all classes of stock of the corporation. (If there is 
more than one 25%-or-more foreign owner, complete the fields for the person with the 
highest percentage of ownership.) Enter the percentage that person owned and the 
owner’s country of residence.

See section 6038A(c)(5) and the related regulations for the constructive ownership 
rules of section 318 that apply in determining if a corporation is foreign owned.

NOTE
Generally, a 25% foreign-owned corporation with a reportable trans-
action during the tax year must file Form 5472, Information Return of 
a 25% Foreign Owned U.S. Corporation or a Foreign Corporation 
Engaged in a U.S. Trade or Business (screen 5472 in Drake Tax). 
See Form 5472 for filing instructions and penalties for failure to file.

NOTE
If another entity owns 20% or more of the client’s corporation, or 
owns 50% or more of the corporation’s stock entitled to vote, see 
“Schedule K, Line 4” on page 31.
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Schedule K, Line 13

On line 13 of screen K, select Yes if the corporation’s total receipts (line 1a + lines 4 
through 10 on page 1 of Form 1120) are less than $250,000 for the tax year, and its 
total assets at the end of the tax year are less than $250,000.

If the answer to line 13 is Yes, in the lower text box of line 13 enter the total amount of 
cash distributions and the book value of property distributions (other than cash) made 
during the tax year. (An entry here is added to the amount calculated from entries on 
line 5, “Distributions,” on the M2 screen and reflected on page 5, line 13, of the 1120 
return.)

Business Interest Expense and Form 8990

The Tax Cuts and Jobs Act (P.L. 115-97) amended section 163(j) to reflect a limitation 
on the deduction for business interest expense for certain taxpayers in tax years begin-
ning after 2017. Use Form 8990, Limitation on Business Interest Expense Under Sec-
tion 163(j), to figure the amount of business interest expense that is deductible and the 
amount to carry forward to the next year.

Screen Code: 
8990

Screen 8990 is available in Drake Tax from the second Other Forms tab of the Data 
Entry Menu.

Before putting any data in the fields on this screen, enter data all other screens needed 
to complete Form 1120. View the return (press CTRL+V) and note the “Taxable 
Income” on page 1 of Form 1120, then return to this screen and enter the taxable 
amount on line 6. Complete all other appropriate fields on this screen.

If section 163(j) applies to this corporation, the business interest expense deduction 
allowed for the tax year is limited to the sum of:

• Business interest income

• 30% of the adjusted taxable income

• “Floor plan” financing interest expense

For definitions of these an other terms, see the Instructions for Form 8990. Also 
become familiar with Proposed Regulations sections 1.163(j)-1 through 1.163(j)-11 

Disallowed Business Interest Carried Forward

The amount of any business interest expense that is not allowed as a deduction under 
section 163(j) for the tax year is carried forward to the following year as a disallowed 
business interest expense carryforward. 

NOTE
If the answer on line 13 is Yes, the corporation is not required to com-
plete Schedules L, M-1, or M-2. To force the program to print these 
forms, go to the PRNT screen and select Force Schedules G (1120-
C), L, M-1, and M-2 to be printed.
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Who Must File 

According the IRS instructions, a corporation with business interest expense, a disal-
lowed business interest expense carryforward, or a a current-year or prior-year excess 
business interest expense, generally must file Form 8990, unless an exclusion from fil-
ing applies.

The corporation is not required to file Form 8990 if the taxpayer is a small business 
taxpayer and does not have excess business interest expense from a partnership. A tax-
payer is also not required to file Form 8990 if it only has interest expense from an 
excepted trade or business. A small business taxpayer is a taxpayer that “is not a tax 
shelter (as defined in section 448(d)(3)) and has average annual gross receipts of $26 
million or less for the 3 prior tax years under the gross receipts test of section 448(c).”

See “Ownership of pass-through entities not subject to the section 163(j)” in the 
Instructions for Form 8990 for details.

Form 8997, Initial and Annual Statement of QOF Investments 

An investor in a qualified opportunity fund (QOF) uses Form 8997 to inform the IRS 
of the QOF investments and deferred gains held at the beginning and end of the cur-
rent tax year, as well as any capital gains deferred and invested in a QOF in the current 
year, and QOF investments disposed of during the current tax year. When an investor 
acquires or sells the investment, it must also be reported on Form 8949, Sales and 
Other Dispositions of Capital Assets.

Find screen 8997 on the second Other Forms tab of the Data Entry Menu.

Reporting 
QOF 

Investments

From the Part drop list on screen 8997, select which part you are completing:

• Part I: Used to declare the partnership’s QOF investments held at the beginning of 
the current tax year.

• Part II: Used to report the partnership’s capital gains for the current tax year that 
were deferred by investing in a QOF.

• Part III: Used to report the partnership’s QOF investments disposed of during the 
current tax year.

• Part IV: Used to report the partnership’s QOF investments held at the end of the 
current tax year due to current-year capital gain deferrals and prior tax years’ 
deferrals.

For each investment, enter the EIN of the QOF, along with the date the QOF invest-
ment was acquired, a description of the interest acquired, and the amount that was 
short-term deferred gain and long-term deferred gain.

Mark the check boxes at the bottom of the screen as appropriate.

NEW FOR 

2019
Complete screen 8990 and Form 8990 is generated with the return. 
There is no longer a need to attach a PDF version of the form to the 
return.
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Press PAGE DOWN to open a fresh screen and make another selection from the Part 
drop list.

Qualified Opportunity Funds 

There are special rules for eligible gains invested in Qualified Opportunity Funds.

Form 8996 A corporation files Form 8996, Qualified Opportunity Fund, annually to report that 
the QOF meets the 90% investment standard of section 1400Z-2 or to figure the pen-
alty if it fails to meet the investment standard

In Drake Tax, screen 8996 has been added for completing Form 8996. Screen 8996 is 
available from the Other Forms tab of the Data Entry Menu or through a link on 
line 15 of screen B.

Part I certifies that the corporation was organized to operate as a QOF. Part II deter-
mines whether the corporation meets the 90% investment standard for a QOF. Entries 
in Part IV calculate any penalties for each month that the QOF did not hold at least 
90% of its assets in QOZ property.

Complete Parts I, II, IV on screen 8996. Click the link at the bottom of the screen to 
complete Parts V and VI.

QOZ Tract 
Numbers

(New for 2019) On the Parts V and VI screen, select from the Part drop list the form 
part to which data entered in this screen should flow. In the QOZ Tract No. column, 
enter the designated 11-digit census tract number. (To find this tract number, go to 
irs.gov/pub/irs-drop/n-18-48.pdf for a list of Designated Qualified Opportunity Zones, 
listed by state and county. 

See Form 8996 and its related instructions for more information.

Schedule K-1

The 1120 package includes a K1P screen (accessible from the first Other Forms tab 
of the Data Entry Menu) for entering information from Form 1065, Schedule K-1. 
This screen works the same as it does for the other packages, with amounts automati-
cally flowing to the appropriate forms, schedules, and lines.

In addition:

• Ordinary income flows to Form 1120, page 1, line 10, “Other income,” with the 
partnership name and EIN (required information).

• Ordinary losses flow to Form 1120, page 1, line 26, “Other deductions,” with the 
partnership name and EIN (required information).

Depending on your setup, the partnership name and EIN appears in a statement (for 
example, “Statement #1”) referenced on line 10 or line 26.

TIP See “K-1 Export.” below, for details on exporting K-1 data directly from 
a partnership return into the corporation’s K1P screen of Drake Tax.
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Codes or lines that don’t flow to any other place may require additional information 
not available to the program and must be manually entered in the proper place in the 
return.

Missing ID 
Number 

If the corporation received a Schedule K-1 from a partnership and the partnership did 
not have an ID number—for instance, if the partnership was foreign and did not have 
an EIN—type “F” into the Partnership EIN field of the K1P screen and the word 
FOREIGNUS is automatically entered. If the partnership had applied for an SSN or 
EIN but had not yet received an ID number, type “A” to have APPLD FOR entered 
in the Partnership EIN field.

K-1 Export

Take the following steps to export K-1 information from a partnership return into the 
K1P screen of an 1120 return. (The K1P screen in the 1120 does not have to be cre-
ated beforehand.)

1. Open the partnership (1065) return in Drake Tax and go to View/Print mode.

2. Click K1 Export in the View toolbar. If any K-1s are not eligible to be exported, 
that list appears. Click Next to continue; otherwise, the Export K1s window is 
opened, containing a list of K-1s eligible for export.

3. All SSNs and EINs in the list are eligible for export. Remove the check mark from 
the box to the left of any EINs or SSNs you do not want to export (Figure 5 on 
page 36).

4. Click Export. The K-1 data is displayed in the 1120 return in the program.

Figure 5: Exporting K-1 data from a partnership return into
the corporation return for Seay’s Trucking
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Oil and Gas Depletion Worksheet

The Oil and Gas Depletion Worksheet calculates oil and gas depletion and gives your 
clients the best possible deduction.

The DEPL screen is completed in the Business packages in a similar fashion to the 
1040 package. For details, see “Oil and Gas Depletion Worksheet” on page 22 of this 
supplement and in Chapter 5 of the 2019 Drake Tax User’s Manual.

State-Specific Information

The program automatically generates a return for the corporation’s resident state. Use 
screen 2 to enter company information as it should appear on the state return.

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group), and state-specific dates and numbers for iden-
tification.

Contact Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2. This screen has fields for the following types of contact 
information:

• Name and address of registered agent

• Principal place of business

• “Books in care of”

• General contact information for the name, title, email address, ID number, and 
telephone number of the corporation’s contact person.

Other States

Data for states other than the resident state must be entered manually in state data 
entry. To access state data entry, select the States tab from the Data Entry Menu, or 
enter the two-letter state code in the selector field and press ENTER.

Multi-State 
Appor-

tionment

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment 
screen. This screen (Figure 6) provides one central location for entering all state 
apportionment information instead of having to open each needed state’s screen. 

In addition to making data input faster and easier, this feature provides two work-
sheets: a summary worksheet, “Wks SA-SUM,” that can be used to verify input, and a 
reconciliation worksheet, “Wks SA-REC,” that ties the total of the state amounts to 
the federal return figures. These worksheets are available in View/Print mode.

NOTES
• The link to screen 2 is on the States tab, (or enter 2 in the selector 

field and press ENTER.)

• The company information fields on screen 2 apply for the resident 
state only.
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The individual state apportionment screens can be used to override data entered on the 
APPT screen.

Figure 6: State APPT screen

APPT Screens The APPT screen is opened to the Sales tab. Links at the top of this screen open the 
Payroll, Property, and Additional Property information tabs for each state selected. 
These screens and their uses are listed in Table 1:

You may enter up to four states on one APPT screen. If you need room for more than 
four states, press PAGE DOWN for a new APPT screen. The same state can be entered 
more than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the 
reconciliation worksheet. Not every item appearing on the federal return may be sub-
ject to multi-state apportionment. When you select OT, the data entered becomes a 
reconciling adjustment amount to aid in tying to the federal return. 

NOTE
Mark the Zero Apportionment check box (Figure 6) to add a state but 
not include any apportionment data. This will include the state on the 
apportionment summary worksheet “Wks SA-SUM,” available through 
View/Print mode.

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state

Payroll Enter salary, wage, commission, and labor amounts for 
each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, plus select additional apportionment factors 
from drop lists

Additional Property Select additional apportionment factors from drop lists
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Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information will flow to that state’s return.

Other Information and Overrides

Screen 1 includes fields for miscellaneous codes, invoice numbers, and several over-
ride fields. See “Listing a Different Firm, Preparer, or ERO on a Return” in Chapter 2 
of the 2019 Drake Tax User’s Manual for more information.

An option was added to Update Misc Codes on Screen 1, available during the update 
process (Last Year Data > Update Client 2018 to 2019) in the federal business pack-
ages. This option allows you to bring forward from 2018 the miscellaneous codes and 
drop lists you created last year. For more information on using these code fields, see 
“Miscellaneous Codes” in Chapter 5 of 2019 Drake Tax User’s Manual. 

Schedule L (Balance Sheet per Books)

Schedule L is required if the corporation’s total receipts for the tax year or its total 
assets at the end of the year are greater than $250,000.

Flow of Information

Many of the entries made elsewhere (such as inventory information from Schedule A) 
flow automatically to the generated Schedule L. Depreciable asset information from 
the 4562 screen and intangible assets and amortization also flow to Schedule L.

Use the corporation’s balance sheet to enter data directly onto Schedule L.

Reconciliation Totals Displayed 

Schedule L and Schedule M-2 reconciliation totals are displayed on screens L, L2, 
and M2 to facilitate reconciliation of the balance sheet (item #1 in Figure 7 on 
page 40).

NOTES
• The Ending amount entered on the Property and Addition Prop-

erty screens in Drake19 will become the Beginning amount for 
property on the APPT screen when the client’s return is updated 
next year in Drake ’19.

• Not all data entered on screen ATP is updated each year.

NOTE See “Importing Trial Balance Information” on page 58 for information 
on using the trial balance import to enter Schedule L data.
Tax Year 2019 39



Schedule L (Balance Sheet per Books) Drake Tax Manual Supplement: 1120
Figure 7: Beginning- and End-of-Year totals displayed on screens L and L2 (#1);
force printing end-of-year totals (#2)

Note that the totals from the balance sheet’s subsidiary schedule (from the SCH2 
Screen links) also appear in the BOY Totals and EOY Totals columns of the L and 
L2 screens.

If you make any changes to the data, recalculate the return (press CTRL+C) for those 
changes to be displayed on the screen.

Force-Printing Final End-of-Year Totals

Normally, if you mark Final on screen 1, indicating that this is a final-year return, 
Drake Tax “zeros out” the EOY Totals column of Schedule L. Mark the Force-print 
final end of year check box on screen L (see item #2 in Figure 7) to display those 
totals in the EOY Totals column.

NOTE
The end-of-year totals also appear on screen M2 (Retained Earnings). 
From either screen L, L2, or M2, press PAGE UP and PAGE DOWN to 
toggle among screens L, L2, and M2 to make reconciliation easier.
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The SCH2 Screen

The SCH2 screen (see Figure 8) is used to provide detailed information required by 
the IRS for certain lines on Schedule L. The amounts are carried to Form 1120 and 
printed on an attached statement.

This screen can also be used in place of the actual L screen in Drake Tax. If you use 
this screen for all applicable lines on Schedule L, you do not need to make any entries 
on screen L.

Entering 
Information

To create a statement for a line using the SCH2 screen, select the desired line from the 
Line Number drop list and enter descriptions and their corresponding amounts.

Figure 8: SCH2 screen fields for line number, description, and amounts

Once the information is entered, or if additional descriptions are required for the line, 
press PAGE DOWN to access a new screen.

Statements The total amounts entered on the SCH2 screen are not displayed on the actual L 
screen in the program. They are, however, printed on the return where needed, with 
references to the corresponding statements.

If a line is required, a statement (labeled “STATEMENT” in the drop list and “STATE-
MENT” or “STM” in View/Print mode, depending on your Setup Options) is pro-
duced and is e-filed with the return.

SCH2 and 
Trial Balance 

Import 

Typically, one or more SCH2 screens are needed for Schedule L items. Data for the 
SCH2 screens cannot be entered directly into the trial balance worksheet, although the 
amounts must be included in the trial balance worksheet for the worksheet to balance. 
When the return is produced, Schedule L reflects the amounts imported from the trial 
balance worksheets but does not include the totals of the SCH2 screens; this data must 
be entered on the SCH2 screens.

NOTE To access the SCH2 screen from screen L, click an SCH2 Screen 
link. Press ESC to return to screen L.

NOTE
All line selections and screen descriptions are carried to the next 
year, and year-end amounts are carried to the beginning-of-year col-
umn, when the returns are updated.
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See “SCH2 Detail” on page 66 for detailed instructions using the trial balance work-
sheet for SCH2 items and amounts.

Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the unappropriated retained earnings amount on Sched-
ule L by the difference between the total assets and the total liabilities and capital 
before the adjustment. For example, if assets are $1,000 and liabilities and capital are 
$900, the program increases the unappropriated retained earnings by $100.)

The program makes the adjustments due to differences in the balance sheet. Incorrect 
data entry could cause these differences but they are usually the result of one of the 
following issues:

• An asset deleted from 4562 screen (Depreciation - Detail Items) instead of being 
indicated as sold

• Beginning inventory amounts adjusted on Schedule A or ending inventory 
amounts were entered incorrectly

• Amounts erroneously deleted from or changed on screen L

To reconcile the differences, it is best to compare the corporation’s beginning and end-
ing balance sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

 Schedules M-1 and M-3, Reconciliation of Income per Books

Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the 
year equal or exceed $10 million, and pages 1-3 of Schedule M-3 are required if the 
total assets equal or exceed $50 million. If the corporation’s assets do not equal or 
exceed $10 million but you want to voluntarily file Schedule M-3, or if the corpora-
tion’s assets do not equal or exceed $50 million and you wish to file the complete
M-3, go to screen M3 and make a selection from the Voluntarily file M-3 drop list. 
Choose to print just page 1 of Schedule M-3 or the complete M-3.

NOTE If you are using trial balance import, autobalance must be turned off 
prior to import. See “Preparing to Use Trial Balance Import” on page 59.

NOTE If the corporation is filing Schedule M-3, Schedule M-1 is not generated. 
Any entries on the M1 screen (for Schedule M-1) should be deleted.
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Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, the corporation 
must reconcile book income with the taxable income.

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as “permanent” or “temporary,” and as “favorable” or “unfa-
vorable.” Examples of both kind of differences are shown in Table 2.

Schedule M-3

Schedule M-3 is completed using the following screens, all found on the General tab 
of the Data Entry Menu:

• M3, M31, M32, and M33 — for Parts I, II, and III of the Schedule M-3

• M3B — for Schedule B Additional Information for M-3 filers

• SCH3 — for subsidiary schedules for Schedule M-3 and Form 8916-A

• M3S — for supplemental statements

• 8916 — for reconciling of M-3 with taxable income for mixed groups

• 916A — for supplemental attachments to the M-3

If the corporation is required to file (or voluntarily files) Schedule M-3, the corpora-
tion must file Form 1120 and all attachments and schedules, including Schedule M-3.

Parts I-III Part I of Schedule M-3 asks certain questions about the corporation’s financial state-
ments and reconciles financial statement worldwide net income (loss) for the corpora-
tion (or consolidated financial statement group, if applicable) as reported on Schedule 

Table 2: Examples Book-to-Tax Differences for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary Items that will be reported for both 
tax and book purposes, but not 
during the same tax year

- Depreciation
- Gains or losses on the sale of
   depreciated assets

Favorable Items that reduce taxable income - Instances in which tax depreciation
  amount is greater than book depre-
  ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment

NOTE
Certain income and deduction amounts and adjustments flow from 
Form 1120 to Schedule M-3 and Form 8916A in the program, but all 
other M-3 data must be entered manually.

If Schedule M-3 is present in a return, no Schedule M-1 is generated.
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M-3, Part 1, line 4a, to net income (loss) per the income statement of the corporation 
for U.S. taxable income purposes, as reported on Schedule M-3, Part 1, line 11.

Parts II and III reconcile financial statement net income (loss) for the U.S. corporation 
(or consolidated tax group, if applicable) as reported on Schedule M-3, Part II, line 30 
(column d), to taxable income (loss) as reported on Form 1120, page 1, line 28.

Certain items that are readily available flow to the M-3, but do not balance the M-3 
automatically. To ensure that the M-3 balances, additional data entry may be required 
on the M31, M32, and M33 screens.

Schedule B Schedule B, Additional Information for M-3 Filers, is required when Schedule M-3 is 
present in a return. Use screen M3B.

The SCH3 
Screen

The SCH3 screen is similar to the SCH2 screen and is used to provide detailed infor-
mation for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3 
and 8916A screens. For more information on using this type of screen, see “The SCH2 
Screen” on page 41.

Schedule M-2 (Unappropriated Retained Earnings)

Information from Schedule M-2, “Analysis of Unappropriated Retained Earnings” ties 
to the Schedule L, line 25, portion of the balance sheet. Increases, distributions, and 
other decreases to the retained earnings are entered on Schedule M-2. Unappropriated 
retained earnings refer to corporation income that has not been distributed to share-
holders that is available for dividend distribution.

M-2 Troubleshooting

The beginning Unappropriated Retained Earnings flow from Schedule L (Balance 
Sheet), and the “Net Income (Loss) per books” flows from the completed Schedule 
M-1 or M-3 on Form 1120. These numbers, combined with amounts entered on the 
M2 screen, are used to calculate the ending Unappropriated Retained Earnings.

If the computed amount does not match the amount in the completed Schedule L (Bal-
ance Sheet), the system produces an EF Message that says the M-2 is out of balance. 
Solving this problem can be challenging, since it can have any of several causes:

• The beginning balance sheet entries are inaccurate

• The Beginning of Year unappropriated retained earnings amount (line 25 on 
screen L) entered on the SCH2 screen for line 24 (“Retained earning-Appropri-
ated”) is incorrect

• Autobalance is not turned on (See “Autobalance” on page 42.)

• The ending balance sheet entries are inaccurate

• The net income per the tax return is inaccurate

• The reconciling items on Schedule M-1 or M-3 need to be adjusted

• The reconciling items on Schedule M-2 need to be adjusted
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If the items are off by a couple of dollars or less, resolve the problem by entering a 
reconciling item on the M2 screen:

1. Double-click in a field on the M2 screen to open a detail (CTRL+W) worksheet.

2. Enter the word “Rounding” as the description and enter an amount.

3. Press ESC. The program returns to the M2 screen.

If the problem is not resolved, it may be necessary to do a detailed comparison 
between the corporation’s financial records and the completed return information.

Schedule O (Controlled Group Information)

Schedule O, in the past, was used to report the apportionment of taxable income, 
income tax, and certain tax benefits between all component members of a controlled 
group. With the changes to tax law, such apportionment is no longer allowed, so 
Schedule O is purely an informational form.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. The required 
adjustments flow to the appropriate line of the return and to Schedule M-1 or M-3. 
Manually reducing the expenses/deductions or increasing the income for these credits 
causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following cred-
its:

• Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts 
for the following credits:

• Form 5884, Work Opportunity Credit

• Form 6765, Credit for Increasing Research Activities

• Form 8820, Orphan Drug Credit

• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

• Form 8881, Credit for Small Employer Pension Plan Startup Costs

• Form 8932, Credit for Employer Differential Wage Payments

• Form 8941, Credit for Small Employer Health Insurance Premiums

NEW FOR 

2019
Certain “extender” tax credits have been revived for 2019. In fact, these 
extenders are retroactive, so taxpayers who were unable to claim these 
credits in 2018 are now eligible for to file amended returns.
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Adjusting Charitable Contributions/NOL

Corporations with a net operating loss (NOL) carryover from any taxable year must 
apply the special rule of IRC section 170(d)(2)(B) for charitable contributions. The 
rules are designed to prevent a double tax benefit through interaction of NOL and 
charitable contribution carryovers. The excess charitable deduction can reduce taxable 
income only once. Under these rules, a corporation’s charitable contributions carry-
over (but not the NOL carryover) must be reduced to the extent the charitable contri-
bution deduction, in computing the taxable income of an intervening year, would 
increase the NOL to a succeeding year.

Limitation on 
Deduction

The total amount claimed cannot be more than 10% of taxable income (line 30) com-
puted without regard to the following:

• Any deduction for contributions

• The special deductions on line 29b

• The deduction allowed under section 249

• Any net operating loss (NOL) carryback to the tax year under section 172

• Any capital loss carryback to the tax year under section 1212(a)(1)

To prevent the double benefit from the excess charitable contribution deduction when 
there is a charitable contribution on the return and an NOL carryover, the program 
makes the IRC section 170(d)(2)(B) adjustment. In this situation, the charitable contri-
bution carryover amount is reduced on column C of the Contribution Limitation/Car-
ryover worksheet (Wks Contrib in View/Print mode), and the NOL carryforward is 
increased on the ATT_NOL worksheet.

Elections
Screen Code: 
ELEC

The ability to make certain tax elections is included in the business packages. Elec-
tions are selected from the Return Elections section of the ELEC screen (available 
from the Miscellaneous tab of the Data Entry Menu).

Making an Election in Drake Tax

To indicate that the corporation is making an election:

Screen Code: 
ELEC

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry 
Menu (or by typing ELEC in the selector field and pressing ENTER).

2. Make a selection from the Election drop list (Figure 9 on page 47).
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Figure 9: Election drop list

3. Complete all other fields as applicable. Press F1 in any field to learn if that field is 
required for your selection and the type of information that may be needed. For 
example, the help text for the Date or year-ending field (Figure 10) shows that 
the field is required only for election options 08, 09, 11, and 15, and it explains 
what, specifically, should be entered for each of these elections.

Figure 10: Help text for Date or year-ending field on ELEC screen

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “Statement ELXX,” where “XX” is the number of the 
election. For example, election “01 - General Election Statement” is generated as 
Statement EL01.

NOTE
If the election option you selected is not listed in the help text for a field, 
then that field should be left blank. For example, if you chose election 
“01 - General Election Statement,” you would not need to enter any-
thing into the Date or year-ending field.

NOTE
If, at Setup > Options > Calculation & View/Print tab, you 
selected not to Print only one overflow statement per page, 
election statements are not numbered but each is listed within a 
“Statement.”
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The election statement includes the election title, election wording, and any additional 
information required for the election, such a date or amount.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

Safe Harbor Elections

The Building qualifies for Section 1.263...” check box on screen 4562 allows you to 
apply a small taxpayer Safe Harbor election to the building listed in the Description 
field. An election statement (“ELEC”) is produced in View/Print mode and the build-
ing description as entered in the Description field is included in the election state-
ment.

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance.

Another safe harbor election available from the Elections drop list on the ELEC 
screen is the Sec. 1.263(a) - 1(f) de minimis safe harbor election.

Election statements are generated with the return (Figure 11).

Figure 11: Election statement generated with ELEC screen selection

Making Changes on the Fly

Use the PRNT screen to override most program defaults.

Suppressing/Forcing Documents

To suppress or force the printing of certain documents, go to the PRNT screen and 
select the desired options. Many “on-the-fly” changes override the options established 
in Setup.

NOTE
This election can also be made from the Election drop list on the 
ELEC screen.

This Safe Harbor election covers buildings only.
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You can force the program to print the following 1120 items on a return:

• Form 1125-E

• Schedules G (1120-C), L, M-1, and M-2

• Form 4562

• Next-year depreciation listing

• Inactive returns

• PIN for the preparer’s alternative electronic signature

The PRNT screen can also be used to suppress printing of the following items on a 
return:

• Form and attachment references (References are printed by default.)

• Form 4626, Alternative Minimum Tax—Corporations

• Proformas used for next year’s tax season

Calculation and Other Options

The following calculation and other options are available on the PRNT screen:

• Calculate Form 2220 penalty — Select this box to have the program calculate 
the penalty for Form 2220, Underpayment of Estimated Tax by Corporations. 
(The program retains the rates as of 12/31 of the calendar year. If a corporation 
has a fiscal year end, the preparer must enter the effective rates manually.)

• Do not calculate WK_1120W based on 2019 taxable income — Worksheet 
Wks 1120W is an estimated tax worksheet based on the current tax year taxable 
income. Select this box to stop generation of this worksheet.

• Calculate Form 4466 (application for quick refund) — Form 4466, Corpora-
tion Application for Quick Refund of Overpayment of Estimated Tax. (A check 
mark in this box is the only entry needed to generate the form.)

• Turn off autobalance — For more information on the autobalance feature in 
Drake, see “Autobalance” on page 42.

• Prepare Form 7004 extension based on screen 1 info — Select this box to pre-
pare a six-month extension based on the information that has already been entered 
into the return. Note that screen 1 must be completed to prepare an extension.

Overriding Other Setup Options

The following program defaults can be overridden from the PRNT screen:

NOTE
Form 1125-E is required if total receipts (line 1a + lines 4 through 10) 
are $500,000 or more.

Schedules L, M-1, and M-2 are not required if receipts and total assets 
(Schedule K, line 13) are less than $250,000.

NOTE To prepare Form 7004 based on information other than (or in addition 
to) that provided on screen 1, use the 7004 screen.
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• Date to print on return

• Amount on Form 1120, page 1, item D (“Total assets”)

• IRS Service Center

Electronic Filing

Steps to e-file Form 1120 are the same as to e-file Form 1040, with the exception of 
bankruptcy returns, which must be paper-filed.

Common Reject Codes

If one or more of the following IRS reject codes are generated when you e-file an 1120 
return, you must contact the IRS for further information. The IRS e-Help Desk tele-
phone number is (866) 255-0654.

• Reject Code F1120-307-01 — Filer’s TIN and “Name Control” in the return 
header must match data in the e-file database unless Form 1120, Item E (3), check 
box “Name Change” is marked.

• Reject Code R0000-900-01 — The return type indicated in the return header 
must match the return type established with the IRS for the EIN.

• Reject Code R0000-905-01 — Electronic Filing Identification Number (EFIN) in 
the return header must be listed in the e-file database and in “accepted” status. If 
you get this reject code, you must update your e-file application to include the 
1120 return type. This should be done at the IRS website. Review publication 
3112 for details.

• Reject Code R0000-932-01 — If “Amended Return” or (Superseded for 1120/
1120S) check box is not selected, then Taxpayer TIN in the return header must not 
be the same as a TIN of a previously accepted paper return for the return type and 
tax period indicated in the tax return.

• Reject Code R0000-933-01 — If “Amended Return” or (Superseded for 1120/
1120S) check box is not selected, then Taxpayer TIN in the return header must not 
be the same as a TIN of a previously accepted electronic return for the return type 
and tax period indicated in the tax return.

NOTE
A default due date for filing is printed on all letters and filing instruc-
tions generated with a return. You can override the default by enter-
ing an alternate due date in the Due date to print on letter and 
filing instructions field on the new COMM screen, also listed on the 
Miscellaneous tab of the Data Entry Menu.

NOTE
If a reject associated with the return’s “Name Control” occurs, some of 
your questions can be answered on the IRS’s website. For details, log 
in to the IRS website or go to irs.gov/businesses/corporations/using-
the-correct-name-control-in-e-filing-corporate-tax-returns 

See “Name Control” on page 51 for more.
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Name Control

(New for 2019) A Name Control field has been added to the EF screen. Use this 
Entity Name Control Override field only if your client has obtained a Name Control 
from the IRS.

A “Name Control” is established by the IRS when the entity requests an Employer 
Identification Number (EIN). The IRS creates the name control from the legal name 
listed on the Form SS-4, Application for Employer Identification Number.

Filers who cannot determine the correct Name Control must contact the Business Spe-
cialty Tax Line at (800) 829-4933 for assistance. The caller must qualify in one of the 
following categories to receive assistance:

• Be designated as the Paid Preparer and the “Paid preparer” check box on the 
return is marked for the last filed return (The designation expires one year after 
the due date of the return in question. There are no exceptions or extensions to the 
expiration date)

• Have or provide Form 8821, Tax Information Authorization, authorizing the caller 
to discuss the corporation’s entity information

• Have or provide Form 2848, Power of Attorney and Declaration of Representa-
tive, authorizing the caller to discuss the corporation’s entity information

In general:

• The Name Control consists of up to four alphanumeric characters.

• The Name Control should be determined from the information specified on the 
first name line. Generally, the Name Control is derived from the first four charac-
ters of the entity name.

• An ampersand (&) or hyphen (-) are the only special characters allowed in the 
Name Control.

• The Name Control can have fewer, but no more than, four characters. Blanks may 
be present only at the end of the Name Control.

Do not include DBA or FBO as part of the Name Control.

Special Types of Returns

This section covers 52-53–week year returns and inactive returns. Both types of 
returns can be e-filed using Drake Tax.

Electing a 52-53–Week Year (Initial Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the Year screen.

NOTE
If a reject associated with the return’s “Name Control” occurs, some of 
your questions can be answered on the IRS’s website. For details, log 
in to the IRS website or go to irs.gov/businesses/corporations/using-
the-correct-name-control-in-e-filing-corporate-tax-returns 
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To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year begins and 
Fiscal year ends dates. Use the MMDDYYYY format, as shown in the example 
in Figure 12.

2. Mark the 52-53-week tax year box.

Figure 12: In this example, the fiscal year begins 09/28/2019 and ends 09/25/2020
(the Friday closest to the end of April), giving the entity a 53-week year for 2020.

3. Click the Year link to open the Short-Year Election screen (Figure 13).

Figure 13: Elections for 52-53-week tax years

4. For line 1, select the month in which the 52-53–week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the 
Fiscal year ending field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

Inactive Returns

Entities that are inactive but still required to file returns may e-file inactive returns in 
Drake Tax. To indicate that a return is inactive:

NOTE
An entity that has filed returns in the past must complete only steps 1 
and 2 of this process. An entity that has never filed a return before must 
continue with steps 3 through 6.

NOTE
Once a 52-53–week year is selected, the entity must use that account-
ing period every year. To change accounting periods, the entity must 
submit to the IRS Form 3115, Application for Change in Accounting 
Method.
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1. Go to the PRNT screen, accessible from the General tab.

2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, in the box above line 1c). Zeros (“0”) are dis-
played where required by the IRS in order for amounts to be properly included in the 
e-file data.

For detailed instructions on e-filing returns in Drake Tax, see 2019 Drake Tax User’s 
Manual.

Foreign Tab

Use screens on the Foreign tab of the Data Entry Menu for entering data on foreign 
financial accounts, for filing FinCEN Form 114, Report of Foreign Bank and Finan-
cial Accounts, and Form 8804, Annual Return for Partnership Withholding Tax allo-
cable to foreign partners.

Also available on the Foreign tab are the screens used in completing Form 8938, 
Statement of Specified Foreign Financial Assets, Form 5472, 25% Foreign-Owned 
U.S. Corporation, and Form 5471, Information Return of U.S. Persons with Respect to 
Certain Foreign Corporations.

For more on completing FinCEN Form 114, see “Foreign Financial Accounts” in 
Chapter 5 of the 2019 Drake Tax User’s Manual.

GILTI Income 

Section 951A requires U.S. shareholders of controlled foreign corporations to deter-
mine and include their Global Intangible Low-Taxed Income (GILTI) in taxable 
income every year. Section 951A is effective for tax years of foreign corporations 
beginning after 2017, and tax years of U.S. shareholders in which or with which such 
tax years of foreign corporations end. In Drake Tax, open screen I1, GILTI Informa-
tion, available on the Foreign tab of the Data Entry Menu.

For details on using this form, see the IRS instructions for Form 5471 or review the 
field helps on screen I1.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a PDF document must be avail-
able to be attached to the return in order to be e-filed with the return.

IMPORTANT All EF Messages must be cleared in order to e-file an 
inactive return.
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Attach files through the PDF Attachments screen, accessible from the Electronic 
Filing section on the General tab of the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake Tax:

1. Creating a PDF file to be attached

2. Informing the program that a PDF file will be sent with the return

3. Attaching the PDF file for e-file

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return as a PDF document.

2. Save the document to your client’s Drake Documents file, your computer’s desk-
top, or anywhere you can readily find it.

Adding PDF 
Files

To indicate in the program that a PDF file will be sent with the return:

1. Open the return in Drake Tax.

2. From the Data Entry Menu, click PDF Attachments, accessible from the Elec-
tronic Filing section of the General tab (or type PDF in the selector field and 
press ENTER).

3. Fill out the columns on the screen. See Table 3 for examples.

4. Exit the PDF screen.

TIP It’s a good idea to use the Drake Documents scanning feature for this 
step.

NOTE
Many types of documents (for instance, documents created in Micro-
soft Word) can be printed or “saved” as PDF files if you have a PDF 
printer (such as Adobe Reader) installed.

Table 3: PDF Attachment Window Columns

Reference Source Description File Name

Information in this column is 
for your records only; it is 
not transmitted with the 
PDF.

Name or number of regulation, 
publication, or form instruction 
that makes attachments neces-
sary.

Distinctive, easily recogniz-
able file name, followed by 
“.PDF”

Examples:
- Title of house on Oak St.
- Appraisal of Lot 1234

Examples:
- Pub. 123, worksheet XX
- Instructions for IRS Form XYZ

Examples:
- TitleHouseOakSt.PDF
- AppraisalLot1234.PDF
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Because you’ve indicated that a PDF file is attached, the program generates an EF 
Message regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered on the PDF screen, there will 
be three PDF–related items in the View/Print window:

• A red MESSAGES alert (see item #1 in Figure 14)

• An “EF PDF” worksheet that lists all items entered on the PDF screen (item 
#1 in Figure 14)

• An Attach PDF button on the toolbar (item #2 in Figure 14)

Figure 14: The red MESSAGES file and the Attach PDF button

2. Click the MESSAGES file to view the EF Message which provides information 
on how to attach the required documents to the return.

3. Click the Attach PDF button in the toolbar at the top of the window. The EF PDF 
Attachments window (Figure 15 on page 56) displays the information entered on 
the PDF Attachments window in data entry. A red circle with an X means the 
document has not yet been attached; a green circle with a check mark indicates 
and attached document.
Tax Year 2019 55



Form 3115, Application for Change in Accounting Method Drake Tax Manual Supplement: 1120
Figure 15: The EF PDF Attachments window

4. Click the row of a document with a red circled X you wish to attach it to the 
return.

5. Click Browse.

6. Find the proper folder, select the PDF file to attach, and click Open (or double-
click the file name). The X is replaced with a check mark.

Repeat for all documents with an X. When all documents have been attached to a 
completed return, recalculate the return to make sure all EF messages have been 
cleared. If so, the return is ready to be e-filed.

Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any material item.

Form 3115, Application for Change in Accounting Method, is eligible for e-file, but 
an additional copy of the form must be mailed to the IRS national office unless the 
Appendix of Rev. Proc. 2011-14 of other published guidance requires the copy to be 
filed with the IRS office in Ogden, UT. (See IRS instructions for details.)

Drake Tax customers can fill out and e-file Forms 3115 and related schedules and 
attachments for corporation returns.

Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible 
from the Change in Accounting Method box, located under the second Other 
Forms tab of the Data Entry Menu (Figure 16 on page 57).
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Figure 16: Screens for Form 3115, Application for Change in Accounting Method

The screens accessible from the Change in Accounting Method section include:

• Screen 3115 (Change in Accounting Method) — Used to access fields for Form 
3115, including Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the software

• Screen ATT2 (Pt II Ln 14 & Pt III Ln 24b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in 
Figure 17 on page 58) that allows you to link a screen or attachment to a particular 
Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake Tax. The first should be “1,” the second “2,” and so on. 
When using other screens, such as the 311E or ATT screens, you can use those multi-
form code numbers to indicate with which instance of Form 3115 the 311E or ATT 
screen should be associated.

Form 3115 Screens

When you open the 3115 screen from the Data Entry Menu, the program displays the 
first of five 3115 screens. These five screens are:

• Part I (Form 3115, Part I)

NOTE If only one Form 3115 is being submitted, you do not need to enter any-
thing in the Multi-form code box.
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• Part II (Form 3115, Part II)

• Parts III, IV (Form 3115, Parts III and IV)

• A, B, C (Form 3115, Schedules A, B, and C)

• D - Parts I, II (Form 3115, Schedule D, Parts I and II)

• D - Part III (Form 3115, Schedule D, Part III)

As shown in Figure 17, you can access these 3115 screens by clicking a link at the top 
of any of the 3115 screens.

Figure 17: Tab links on 3115 screen

For details on how to file Form 3115, see IRS Revenue Procedure 2015-13.

Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF Messages (as applicable) when the return is calculated. All forms, schedules, EF 
Messages, and worksheets are accessible in View/Print mode.

EF Messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 
specifically, are missing. To better understand which attachments are still required, 
compare the ATT screen and the “EF PDF” page to the list on the EF Message.

Importing Trial Balance Information

Drake Tax’s trial balance import feature allows data to be imported into an 1120 return 
from a trial balance worksheet. The trial balance template and importing function has 
the following benefits:

NOTE
Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for 
general automatic change procedures, and to Rev Proc. 2015-14 
for a list of automatic changes to which the automatic change pro-
cedures in Rev. Proc. 2015-13 apply.

TIP
See Screen Help (accessible from the 3115 screen toolbar, from the 
right-click menu, or by pressing CTRL+ATL+?) to access links to view 
the 3115 instructions through the IRS website.

NOTE
All EF Messages must be eliminated before the return is eligible for 
e-file. EF Messages for Form 3115 attachments are eliminated 
when all required statements have been attached to the return. 
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• Eliminates the need to duplicate entries

• Reduces data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in 
Drake 2008 or later. Like several other functions of the tax program, this feature 
requires Microsoft Excel (version 2000 or later).

First, if you haven’t already, create a client file (open a new return) in Drake Tax 2019 
or update an existing client file from the prior year. Then create a trial balance work-
sheet. (See “Opening a Template” on page 60.)

Then take the following steps to ensure the trial balance import works properly:

• Activate Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro settings are set to “Disable all macros with notification.” To do so, go to 
File > Options in Excel and select the Trust Center tab. Click Macro Settings 
and select Disable all macros with notification, then click OK.

• Disable Autobalance in Drake Tax — (optional) When autobalance is disabled, 
the program is prevented from automatically adjusting the year-end retained earn-
ings or capital amounts, thus allowing you to see any discrepancies in the balance 
sheet. To disable autobalance in Drake Tax, go to the PRNT screen and select 
Turn off autobalance. (Figure 18.)

Figure 18: Disable autobalance from the PRNT screen

NOTE A flow chart of the trial balance importing process is available as 
Appendix A, Trial Balance Import (pages A-1 to A-2 of this manual).

NOTE

In Excel 2007, click the Office button in the upper left and then click 
the Excel Options button at the bottom of the window. (In Excel 
2013, click the File tab then select Options from the menu on the 
left.) Next, select Trust Center from the list at left, then click the Trust 
Center Settings button. Select Macro Settings from the list on the 
left, then choose Disable all macros with notification. Click OK and 
then OK.
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• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the corporation does not meet the filing requirement. If 
this is the case, you have to override the default setting in order to have the 
amounts displayed on Schedule L. To force the Schedule L amounts to be printed, 
go to the PRNT screen and select the applicable check box (Figure 19).

Figure 19: Force-printing Schedules G, L, M-1, and M-2

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail 
(CTRL+W) worksheets that are not required. For example, the IRS does not 
require a detail worksheet for the Gross receipts or sales field on the INC screen; 
if a return has a detail worksheet for that field, the trial balance will not be 
imported correctly into the return. Detail worksheets are indicated by red, as 
shown in Figure 20.

Figure 20: Example of an “unnecessary” detail worksheet

Delete (by pressing CTRL+D) unnecessary detail worksheets prior to import. See 
“Detail Worksheets” on page 62 for more information on using detail worksheets 
in the trial balance.

Preparing Financial Data for Import

To prepare the financial data for importation into the return, the data must be entered 
into Drake Tax’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.

2. Click Import > Trial Balance Import from the toolbar. The preliminary Trial 
Balance Import dialog box is opened.
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3. Click Create New or Open Existing. If opening an existing file, click Open after 
selecting the correct file.

4. If a Security Warning box appears, click Enable Macros.

The trial balance template is displayed in Microsoft Excel.

File Location Whenever a new template is opened, the tax program assigns it a default file location 
and name. Trial balance templates are saved in the “TB” folder of your Drake19 pro-
gram.

To change the name of a file in Excel, open the worksheet, select File > Save As and 
assign the new name.

Template 
Structure

The trial balance template consists of three title rows and six columns. The Entity 
Name and Year End title rows can be edited; double-click a row to change the title. 
Columns are described in Table 4.

Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the 
balance sheet is out of balance and, if applicable, the out-of-balance amount 
(Figure 21 on page 62; see also Figure 24 on page 63).

NOTE
In older versions of Excel, you may see a Security Warning mes-
sage with an Options button. Click Options to open the Security 
Options dialog box, then select Enable this content. Click OK. (In 
Excel 2013, click Enable Content.)

NOTE If saving a trial balance to a different location, make a note of where 
you store it. The program automatically looks in the default directory.

Table 4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake to which the debit or credit 
amount is imported

Form, Page, Sch, and/or line Location of the amount on the printed return

Other Information Additional details for preparers; see “Details for Pre-
parers” on page 65.
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Figure 21: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0).

Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons (Figure 22). (Buttons do not work if macros are disabled; see 
“Opening a Template” on page 60.)

Figure 22: Example of cells that require worksheets

Click a worksheet button to open a worksheet in a new tab. Figure 23 on page 63 
shows an example of the “Other Income” worksheet.

NOTE
Some data cannot be imported from the trial balance worksheet into 
the tax program and must be entered directly into the data entry fields 
within the program. For more on these categories of data, see “Spe-
cial Conditions” on page 65.
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Figure 23: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the Corp TB tab (labeled “1” in Figure 23), 
or the Click to return to TB button above the worksheet tabs (labeled “2” in 
Figure 23). Note that a detail tab (the “Other Income Detail” button labeled “3” in 
Figure 23) might include one or more detail worksheets.

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 24).

Figure 24: Out-of-balance amount is highlighted if columns are out of balance.

NOTE
Do not create detail worksheets in data entry of Drake Tax if the trial 
balance worksheet does not provide an equivalent detail worksheet; 
otherwise, the trial balance will not be imported correctly.
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In addition to credit and debit totals, the main trial balance worksheet displays the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the program.

Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. (In older 
versions of Excel, click the Office button in the upper-left corner and select Save. In 
Excel 2013, click the File tab then Save.) To re-name a file when saving, select File > 
Save As. Trial balance templates are saved in the “TB” folder of your Drake19 pro-
gram.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake Tax, the trial bal-
ance information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.

2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 
Trial Balance Import dialog box is opened.

3. Click Next.

4. Enter or select the trial balance file to be imported. If necessary, click the button to 
the right of 1. Import File Name (blue circle in Figure 25) to browse to the proper 
folder. By default, each trial balance file is an Excel (.xls) file displaying the
client’s name and ending in “TB” for trial balance, as shown in the example in 
Figure 25. (See “File Location” on page 61.)

Figure 25: Selected file to import

5. Select the Trial Balance Additional Import Options. (See “Additional Import 
Options” following this procedure.)

6. Click Next and wait for the import to be completed.

7. Click Finish.

NOTE The data cannot be imported if the worksheet is out of balance.

NOTES

Not all trial balance data can be imported directly into a return. For 
information on program limitations, see “Special Conditions” on 
page 65.

If you are already in the Trial Balance Import tool for the selected return, 
go to the Trial Balance Import window in Drake Tax and start at Step 3 
of the following procedure.
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The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

Additional 
Import 

Options

The program can import the following additional information when importing the trial 
balance data: Select the items to import or click Select All then click Next.

Special Conditions

Some trial balance items cannot be entered into the trial balance worksheet and must 
be typed directly into Drake Tax data entry. Other items should be entered into the 
worksheet for balance purposes but are not imported to data entry; these must be 
entered separately and the calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most trial balance items are imported directly to the location indicated in the program 
and on the return. For example, the amounts shown in Figure 26 go to Schedule L, line 
1, column d in the program and are shown on page 5, line 1, column d of the 1120 
return.

Figure 26: Trial balance worksheet indicates where an amount
will go in Drake Tax and on the return

Other Info 
Column

The “Other Information” column in the trial balance worksheet indicates special con-
ditions and additional information regarding certain rows. Table 5 on page 66 
describes the most common notes in this column.

NOTE
If the program does not calculate the trial-balance information as 
expected, you can return to the trial balance worksheet, make adjust-
ments, and import the worksheet again.

Buildings & other depreciable assets Accumulated depreciation

Goodwill & other intangible assets Land

Accumulated amortization Cost of goods sold (COGS) depreciation
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All “does not import” notes are accompanied by further instructions in the column to 
the left of the “Other Information” column, as shown in Figure 27.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “does not import” on the trial balance worksheet 
(Figure 27).

Figure 27: SCH2 screen required for “does not import” items

To complete an SCH2 detail screen in data entry of the tax program:

1. In Drake Tax, open the SCH2 screen for the return.

2. Select the line number from the Line Number drop list.

3. Enter the applicable item descriptions and beginning- and end-of-year totals.

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but 
is not included in the totals shown on the trial balance.

does not import Information cannot be imported and must be entered on 
the appropriate screen in Drake Tax. Screen is specified 
in “Form, Page, Sch...” column to the left of “Other Infor-
mation.”

optional Amount is optional; not required for import, but could 
require direct entry in the software.

(enter deficit as negative) Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases;” when calculating cost of 
goods sold (COGS) in the return, the program takes the 
change in inventory into account for the Schedule A cal-
culation.

[Form or Schedule] may be 
required

Non-financial information (such as names of officers for 
a Schedule E) must be completed in Drake, in addition 
to the financial data entered in the worksheet.

NOTE Alternately, open screen L and click the SCH2 Screen link for the line 
your wish to enter.
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To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat 
steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, the Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screen.

Depreciation On an 1120 return, total depreciation consists of COGS depreciation, which is 
reported on Form 1125-A, Cost of Goods Sold, and any remaining depreciation, 
which is reported on page 1 of the return. For trial balance purposes, enter deprecia-
tion amounts directly into the appropriate fields on the trial balance worksheet.

When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Form 1125-A on the return. Because the remaining 
depreciation can comprise any number of assets, the amount entered on the trial bal-
ance does not flow to the return. To ensure that each component of the total remaining 
depreciation is calculated into the return, each asset must be entered on the applicable 
depreciation screens in data entry.

Other Program Imports

Information from other outside worksheets can be imported into your 1120 return.

Form 4562 
Import

With the 4562 Import function, you can import depreciable assets into Drake Tax 
from Excel worksheets (Excel 97-2003 and Excel 2007/2010 or later), from a TAB 
(tab delimited) file, or a .CSV (comma separated value) file. After the import is com-
pleted, each asset or transaction appears on a separate 4562 screen.

To successfully import depreciable assets from a worksheet into Drake Tax, the work-
sheet must be correctly formatted. The best and quickest way to get a properly format-
ted Excel worksheet is to download a template from Drake Software. To do so:

1. Open a client’s tax return.

2. From the Data Entry Menu toolbar, click Import > Form 4562 Import.

3. Click the Form 4562 Import information and sample spreadsheet link to open 
Drake Software Knowledge Base article 15982 on downloading the worksheet 
template. (Also in that article is a 4562 Import link to an instructional video.)

4. In the 15982 article, scroll down to “2018 - 1120 Import Template.” Click to 
download the template.

NOTE

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a 
way to check that the amount on line 1 of Schedule M-1 is correct. 
Compare the calculated line 1 at the bottom of the trial balance to the 
equivalent line on Schedule M-1 of the calculated return. If the depre-
ciation amounts match but the line 1 amounts differ, an M-1 adjust-
ment could be required.
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The worksheet is downloaded to your computer. Open it and save it where you can 
easily find it, such as the client’s file in Drake Tax, in Drake Documents, or on your 
desktop..

If you use an Excel worksheet from other sources, you can still import the asset infor-
mation into Drake Tax, but you need to aware of certain parameters. For the asset 
information to be imported correctly:

• In an Excel workbook, the import data must be on the first sheet in the workbook.

– View the workbook and check the tabs across the bottom of the window. If 
there is more than one tab, click and drag the worksheet you want to use to the 
left until it is the first tab.

– The name on the tab does not matter.

• The import file must contain the specified columns in the specified order. Each 
column represents a field on the 4562 screen as determined by the column loca-
tion (not by the header labels, which are optional)

• Except for column headers, do not put anything in the import file that should not 
be imported.

• If you include column headers, make sure to start importing on the first data row, 
not the header row. (Start import at row 2.)

• If totals are present, remove them. The totals may be imported, doubling your 
data.

• The best way to enter dates in Excel is to format the date columns as text in 
MMDDYYYY format (separators can be used or omitted).

Form 8949 
Import

With the Form 8949 Import/GruntWorx Trades feature, you can import capital gain 
and loss transaction data into Drake Tax from Excel worksheets (Excel 97-2003 and 
Excel 2007/2010 or later), from a TAB (tab delimited) file, or a .CSV (comma sepa-
rated value) file.

To successfully import transaction information from a worksheet into Drake Tax, the 
worksheet must be correctly formatted. (GruntWorx Trades are already properly for-
matted.) The best and quickest way to get a properly formatted Excel worksheet is to 
download a template from Drake Software. To do so:

NOTE If a column in the template is red, data in that column will not be 
imported into the return. 

TIP

Whether using the downloaded worksheet for the 4562 import or the 
8949 import (see “Form 8949 Import,” following), or building your own, 
you can import the data more than once. When you are sure the correct 
data is imported, you can delete previous import attempts by opening 
the corresponding 4562 screens (or 8949 screens) and pressing 
CTRL+D. 

For more help, see “Form 4562 Import” and “Form 8949 Imports” in 
Chapter 5 of the 2019 Drake Tax User’s Manual.
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1. From the Home window toolbar in Drake Tax, click Support > Drake Software 
Knowledge Base.

2. When the Drake Software Knowledge Base is opened, in the Quick Search field 
in the top-right corner of the window, type 10139 and click the magnifying glass 
icon on the right.

3. After the search has been completed, click “10139: Schedule D Form 8949 Grunt-
worx Trades Import” from the Search Results.

4. In article 10139, scroll down to Attachments and click “2016 and Future…”

The worksheet is downloaded to your computer. Open it and save it where you can 
easily find it, such as the client’s file in Drake Tax, in Drake Documents, or on your 
desktop.

To use the 8949 Import feature:

1. Open a client’s tax return.

2. From the Data Entry Menu toolbar, click Import > Form 8949 Import.

3. In the Form 8949 Import window, review the example spreadsheet format.

4. When you are ready to begin the import process, click Next.

5. When the Form 8949 Import - Step 1 window is opened, click Browse, find your 
worksheet, click Open, then click Next.

6. When the Form 4562 Import - Step 2 window is opened, select the row where 
you wish to begin the import. (If the first row in the asset list is column headers, 
begin the import with row 2.) Click Next.

7. When the Form 4562 Import - Step 3 window is opened. Click Import.

After import, each transaction appears on a separate 8949 screen.

IMPORTANT

• When importing 8949 data into an 1120 return from the 
Drake Tax template, be aware that data in certain cells 
of the worksheet are not imported to screen 8949. For 
instance, the “TSJ” cells, the “AMT” cells, and the 
“QSBS” cells in the template have no corresponding 
fields on screen 8949; when 8949 data is imported, 
those columns are ignored.

• If you are building your own worksheet, however, the 
“AMT” and the “QSBS” columns must be included in the 
worksheet but enter no amounts should be entered; 
when 8949 data is imported, those two columns are 
ignored. For best results, include all columns displayed 
in the “Example Spreadsheet” in Step 3, below.

• Do not include the “EIN (QOF Only)” column when 
building your worksheet.
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.

If you use an Excel worksheet from other sources, you can still import the asset infor-
mation into Drake Tax, but you need to aware of certain parameters. For the asset 
information to be imported correctly:

• In an Excel workbook, the import data must be on the first sheet in the workbook.

– View the workbook and check the tabs across the bottom of the window. If 
there is more than one tab, click and drag the worksheet you want to use to the 
left until it is the first tab.

– The name on the tab does not matter.

• The import file must contain the specified columns in the specified order. Each 
column represents a field on the 8949 screen as determined by the column loca-
tion (not by the header labels, which are optional)

• Except for column headers, do not put anything in the import file that should not 
be imported.

• If you include column headers, make sure to start importing on the first data row, 
not the header row. (Start import at row 2.)

• If totals are present, remove them. The totals may be imported, doubling your 
data.

• The best way to enter dates in Excel is to format the date columns as text in 
MMDDYYYY format (separators can be used or omitted)

EF “Notice” and EF “ACK” Pages

Similar to federal Form 9325, Acknowledgment and General Information for Taxpay-
ers who File Returns Electronically, generated with 1040 returns, the federal business 
packages generate an “EF Notice” page in View/Print mode for the main forms of fed-
eral returns and state business packages generate a “(ST)EF_ACK” page for the main 
forms of state returns.

These are Drake-generated forms that serve the same purpose as Form 9325: an 
acknowledgment that a return has been transmitted through Drake Tax and received 
by the IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being 
processed) or an “R” ack (for a rejected return), the top section of the EF Notice is 
completed, noting the name and address of the client, the return type, the ERO who 
transmitted the return, and a check mark indicating the return was received by the IRS 
or applicable state agency.

NOTES

• Click the 8949 Import Options and the 8949 Import Tool links in 
KB article 10139 to view an instructional video using the 8949 
Import feature.

• For more help, click Help > View Help Documentation from the 
Form 8949 Import window (in Step 2 on page 69) or see “Form 
4562 Import” and “Form 8949 Imports” in Chapter 5 of the 2019 
Drake Tax User’s Manual.
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When you download and process your acknowledgments and receive an “A” ack, the 
second section of the EF Notice is generated, indicating the return was accepted by the 
IRS or state agency and the date the return was accepted. The submission ID number 
is also included.

NOTE

In View/Print mode, various Return Notes appear on the NOTES page. 
These Return Notes provide information or reminders about the return 
but do not prevent e-file. They are informational only.

To keep a specific Return Note from being generated whenever you 
view this return, go to the Miscellaneous tab of the Data Entry Menu, 
select the HIDE screen (or type HIDE into the selector field and press 
ENTER), type the number of the note to hide into one of the boxes, and 
then recalculate the return.
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Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a corporation tax return from a trial 
balance worksheet.

Drake Tax’s specially designed trial balance template and importing function has the following 
benefits:

• Eliminates the need to duplicate entries

• Eliminates data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
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Index

A
accounting method

changing 56, 56–58
address

e-mail 37
entering on Form 1120 12

adjustments and credits 45
advertising expenses 23
affiliated groups 31
amended returns 30–31
amortization 23, 39
APPLD FOR 19, 36
attachments

binary 53–56
PDF, see PDF files
to Form 3115 56

auto-balance 42, 49

B
bad debts 18, 20
bankruptcy 50
book-to-tax difference (Schedule M-1) 43
Business Interest Expense 33

C
calendar years 13
capital gains and losses 17
Carryforward of disallowed expenses 33
carryover of NOLs 24, 46
Change in Accounting Method 56–58
Changes for 2018 9, 10
Changes on-the-fly 48
charitable contributions 21, 46
codes

error/reject 50
multi-form 57
state 37

compensation of officers 19
consolidated returns 16
contact information (for state returns) 37
contributions, charitable 21, 46
controlled groups 24, 45
converting to 1120 11
cost of goods sold, see  Schedule A (Cost of Goods Sold)
credit for tax on fuels 18


credits
carrybacks and carryforwards 25

credits and adjustments 45
Ctrl+W (detail) worksheets 15, 60

D
data entry

trial balance import 62
DBA 12
debts, bad 20
deductions and income 14–24
depletion 22

oil and gas 22, 37
depreciation

and auto-balance errors 42
expense 22
for cost of goods sold (Schedule A) 15
on short-year returns 13
trial balance (business returns only) 67

detail (Ctrl+W) worksheets 15, 60
detail) worksheet 15
direct debit of balance due 27–28
disallowed business expenses 33
doing business as 12
Domestic Production Activities 23

E
e-filing

new features in Drake 50
PDF documents 53–56

Elections
Safe Harbor 48

electronic
funds withdrawal (direct debit) 27
signatures (PIN) 29

employee benefits 23
entertainment and meals 23
estimated tax worksheet 49
estimates 25, 49
exporting K-1 data 36
extensions 28–29, 49

F
Filing Security Information screen 14
final returns

updating 11
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fiscal year returns 13
foreign

tab 53
Foreign Income-Sourced Income and Dividends 16
foreign ownership 32
FOREIGNUS 19, 36
Form 1120-C (U.S. Income Tax Return for Cooperative 

Associations) 12
Form 1120-H (U.S. Income Tax Return for Homeowners 

Associations) 12
Form 2220 (Underpayment of Estimated Tax By Corpora-

tions) 26, 49
Form 3115 (Application for Change in Accounting Meth-

od) 56–58
Form 3800

Unsupported credits 24
Form 4466 (Corporation Application for Quick Refund of 

Overpayment of Estimated Tax) 26, 49
Form 4797 (Sales of Business Property) 18
Form 5884 (Work Opportunity Credit) 45
Form 6252 (Installment Sale Income) 17
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit)

45
Form 6478, Biofuel Fuels Credit 19
Form 6765 (Credit for Increasing Research Activities) 45
Form 7004 (Application for Automatic Extension of Time 

to File) 28, 49
Form 8050 (Direct Deposit of Corporate Tax Refund) 26
Form 8820 (Orphan Drug Credit) 45
Form 8844 (Empowerment Zone and Renewal Community 

Credit) 45
Form 8844, Empowerment Zone and Renewal Community 

Employment Credit) 19
Form 8845 (Indian Employment Credit) 19
Form 8846 (Credit for Employer Social Security and Medi-

care Taxes Paid on Certain Employee Tips) 45
Form 8864, Biodiesel and Renewable Diesel Fuels Credit

19
Form 8873 (Extraterritorial Income Exclusion) 23
Form 8881 (Credit for Small Employer Pension Plan Start-

up Costs) 45
Form 8912 (Credit to Holders of Tax Credit Bonds) 45
Form 8932 (Credit for Employer Differential Wage Pay-

ments) 45
Form 8941 (Credit for Small Employer Health Insurance 

Premiums) 45
Form 8941 (Credit for Small Employer Health-Insurance 

Premiums) 23
Form 8990 (Limitations on Business Interest Expense Un-

der Section 163(j) 33
Form 8993, Section 250, Deduction for Foreign-Derived 

Intangible Income (FDII) 10
Form 8996, Qualified Opportunity Fund 35
Form 8997, Initial and Annual Statement of QOF Invest-

ments 34
Form 8997, Initial and Annual Statement of Qualified Op-

portunity Fund Investments 10

G
gains and losses 18
GBC screen 25
General Business Credits 25
GILTI 53
GILTI income 53
Global Intangible Low-Taxed Income 53
gross receipts 14

H
header information 12

Boxes A through E 14

I
import

4562 67
8949 68

importing trial balance 58–67
inactive returns 52
income

deferred foreign 17
income and deductions 14–24
installment sales 17
insurance proceeds, income from 18
interest

expense 21
income 17, 18

inventory 15

L
limitations

meals and entertainment 23
on NOL deductions 46

M
M-2 out of balance, troubleshooting 44
maintenance costs 20
meals and entertainment 23
Multi-State Apportionment 37

N
name control 51
name control reject 50, 51
net operating losses (NOL) 24, 46
new features in Drake 9
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next-year depreciation listing 49

O
officer compensation 19
oil and gas depletion 22, 37
ordinary gains and losses 18
Other Costs line 5 15
Other Deductions 23
Other Income (Loss) 18
out-of-balance M-2, troubleshooting 44
overpayment, taxes 26
ownership

foreign 32
of stock 31–33
percentages 20

P
parent-subsidiary group 31
PDF documents

e-filing 53–56
Pension and Profit-Sharing 23
percentage, stock and ownership 20
PIN (electronic) signatures 29
printing

statements for Schedule L 41
suppressing/forcing 48

prior-year returns, updating 11

Q
QOZ Tract Numbers 35
Qualified Opportunity Funds 35

R
receipts 14
references to forms and worksheets 49
refunds

direct deposit of 26
state tax 18

reject codes 50
rent paid on business property 20
rental & royalty income 17
repair costs 20
returns

consolidated 16
converting from another type 11
fiscal and calendar year 13
updating 11

S
Safe Harbor Elections 48

salaries 20
SCH2 screen (for Schedule L) 41
Schedule A (Cost of Goods Sold) 15–16, 42
Schedule B (Additional Information for M-3 Filers) 44
Schedule C (Dividends & Special Deductions) 16
Schedule E (Compensation of Officers) 49
Schedule G (Information on Certain Persons Owning the 

Corporation’s Voting Stock) 49
Schedule G (Schedule G (Information on Certain Persons 

Owning the Corporation’s Voting Stock)) 31
Schedule J total tax 24
Schedule K 31
Schedule K, line 13 33
Schedule K, line 3 31
Schedule K, line 4 31
Schedule K, line 5 32
Schedule K, line 7 32
Schedule K-1 35
Schedule L (Balance Sheet per Books) 39–42, 49
Schedule M-1 (Reconciliation of Books with Return) 43, 

49
Schedule M-2 (Unappropriated Returned Earnings) 44, 49
Schedule M-3 (Reconciliation of Books with Return) 43
Schedule O (Consent Plan & Apportionment Schedule for 

a Controlled Group) 45
section

263A costs 15
481 18

security
business packages 14

security screen 14
short-year return 13
signatures, electronic (PIN) 29
signing the return 29
state

codes 37
contact information 37
information 12
multi-state apportionment 37–39
tax refunds 18

stock ownership 31–33

T
tax

and payments 24
-exempt interest 17
on fuels (credit for) 18
overpayment 26
-to-book difference 43
years (fiscal vs calendar) 13

taxes and licenses 21
trial balance import 15, 39, 41, 58–67
troubleshooting the M-2 44
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U
underpayment of estimated tax 26
updating a prior-year return 11

V
vouchers 25

W
wages 20
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